
Hubble --    Help Master Index

              This topic is the master index which can be used as the starting point to navigate thru various help 
topics and tutorials.

Master Index Topics

Overview    Operation, concepts, tips, etc.
Menu commands [Image Based] Menu commands for image based processing.
Menu commands[Document Based] Menu commands for document based processing.
Toolsbox    Tools for adding text, drawing, and edit image.
Glossary                      Terms    related to various operations.
Keyboard and Mouse    Keyboard and mouse usage.



Menu commands [Image Based Processing]

System Menu      Minimize, maximize, close, restore, etc.
File Menu        Operations on file, printer, display, input, output, etc.
Edit Menu      Operations which may modify image or clipboard.
Option Menu      Miscellaneous setting related to preference, performance, display, as 

well as toolsbox, etc.
View Menu      Zoom in, zoom out, hide/show window.
Transform Menu      Geometric transform and image conversion.
Process Menu      Various image processing operation.
Window Menu      Window management commands.
Help Menu      Accessing program and supporting help.
Tools Menu      Alternative way to access toolsbox.

__________________________________________
Related topics:



The Index contains a list of all Help topics available for the Help System. For information on 
how to use Help, press F1 or choose Using Help from the Help menu.



System Menu

                                      The system menu carries out various system and Windows' management 
command such as minimized, maximize, close the application, etc.
__________________________________________
Related topics:



File Menu

The File menu includes commands that enable users to open and save files, establish a new 
workspace, print, setup input device and printer, acquire input, etc.

For more information, select one of the following item under the "File menu" command :

New      Create a new image.
Open      Load and display image file from disk.
Close      Close the window and associated image.
Save                  Save the image on disk file.
Save As      Save the image on disk file with specified name.
Print      Print the image.
Print Setup      Choose printer, set options, and select port.
Acquire      Acquire input from TWAIN compatible device.
Select Source      Select TWAIN compatible device.
Repaint Screen      Repaint screen to eliminate tainted area.
Exit      Quit the program.
__________________________________________
Related topics:



File Exit Command

This command will close all windows and exit the program.

However, users may be asked whether to save file or complete some operation first, if the 
image has been modified or is locked by some operations.

Operations which have to be completed before the window can be closed include capturing 
image, stitching images, and merging two Images. 

Changes made by users using tools from Toolsbox which is not yet committed to the image 
will be lost. Otherwise, users will be asked whether to save the image to file before exit.

__________________________________________
Related topics:

File : Close 



File New Command

Create a new image with specified dimension (size) and image type ( Color, grayscale, etc.) 
and fill the image with the current background color. The new image will then be ready for 
further editing or processing.

This command invokes the Create New Image Dialog to allow users to make the above 
selection. 

__________________________________________
Related topics:

Create New Image Dialog
File : Open 



File Open Command

This command invokes File Open Dialog which lets users select file and file formats. Users 
can change disk drive and directory, file formats, etc. to choose the file they want. Or users 
can enter file name and path directly in the input filename editing box.

__________________________________________
Related topics:

File : New 
File Open Dialog
Open Option Dialog



File Print Command

This command lets users print the whole image or a selected rectangle. 

Before actual printing is taking place, a Print Options Dialog is invoked to allow users make 
any adjustment or customization for the printed output. This include paper margin, size of 
the printed image, region of the image to be printed, etc. Users can specify these options in 
the unit they prefer, e.g. inch, centimeter, pica, or pixel.

__________________________________________
Related topics:

Print Options Dialog
File : Print Setup    

Toolsbox : Rectangle 
Toolsbox : Rectangle : Select Rectangle 



File Print Setup Command

This command allows users to select printer to be used from a list of printers that users have
installed for the window. It also allows users to set options for the selected printer.

This command invoks    Printer Setup Dialog which presents users with a list of printers. After
the printer has been selected, users can cancel the operation, accept the selection and exit, 
or they can invoke the setup dialog box to setup other options for the selected printer.

__________________________________________
Related topics:

Printer Setup Dialog    
File : Print    



File Save Command

This command saves the currently active image to a file.

At the moment, it is implemented as if the    File : Save As command has been invoked.

__________________________________________
Related topics:

File Save Dialog
File : Save As 



File Save As Command

This command allows users to save currently active image to a file, it invokes File Save 
Dialog which allows users to specify filename, file path (drive and directory),    file formats, 
as well as data compression method supported.

__________________________________________
Related topics:

File Save Dialog    
File : Save 



Repaint Screen Command

This command will repaint every window which belong to the program to eliminate some 
possible tainted area resulting from various operation, or because some windows' color 
display are degraded due to palette changes, etc.

__________________________________________
Related topics:



File Close Command

This command closes the current active window.

However, users may be asked whether to save file or complete some operation first.
if the image has been modified or is locked by some operations.

Operations which have to be completed before the window can be closed include stitching 
images, and merging two Images. 

Changes made by users using tools from Toolsbox which is not yet committed to the image 
will be lost. Otherwise, users will be asked whether to save the image to file before exit.

__________________________________________
Related topics:

File : Exit    Toolsbox 



File : Acquire Command

This command calls functions from dynamic link library (DLL) module which supports TWAIN 
compatible device to acquire input from the selected device.

__________________________________________
Related topics:

File : Select Source    



File : Select Source Command

This command select input device from a list of TWAIN compatible device and set that 
device as current active device from which users is used to acquire input.

__________________________________________
Related topics:

File : Acquire    



Edit Menu

The Edit menu includes commands that enable you to move image to and from the 
clipboard,    edit image, combine images in various ways, etc.

For more information, select the Edit menu command name.

Copy to Clipboard Copies Image to the clipboard.
Copy from Clipboard Copies Image from the clipboard.
Capture to Clipboard Capture Image to clipboard.
Capture to Window    Capture Image to a new window.
Paste Pal Paste    palette from the clipboard.
Del Clipboard Deletes Image from the clipboard.
Custom Palette Customize image color table.
Merge Two Image Merge two images.
Stitch Image from Window.Stitch image from another window.
Stitch Image from Clipboard Stitch image from clipboard.
Resolution Set new resolution of the image.
Duplicate Image Clone the current image.
Trim Image Trim unwanted portion of the current image.

__________________________________________
Related topics:



Edit Copy to Clipboard Command

This command copies the whole or rectangular selected area of currently active image to 
clipboard.    .

__________________________________________
Related topics:

Edit : Copy from Clipboard    
Edit : Capture to Clipboard    



Edit Copy from Clipboard Command

This command copies the clipboard contents to a new window. If the clipboard contents is 
empty, the command is grayed (dimmed) and is unavailable to the users.

__________________________________________
Related topics:

Edit : Copy to Clipboard    
Edit : Stitch Image from Clipboard 



Edit Paste Palette Command

This command pastes palette from    clipboard, effectively changing the palette or color table
of current active image. 

The palette to be pasted is shown on the upper strip of the The Palette Window .    

This version implements the "Paste Palette" command through the Custom Conversion and 
Dithering command under the Transform Menu menu.

Custom Dithering Dialog

__________________________________________
Related topics:

Transform : Custom Conversion and Dithering 
Custom Dithering Dialog 

Toolsbox : Palette 

The Palette Window 



Edit Delete Clipboard Command

This command will empty the contents of the clipboard.    

__________________________________________
Related topics:

Edit : Copy to Clipboard 
Edit : Copy from Clipboard 



Edit Custom Palette Command

This command enables users to rearrange or modify the color table and palette associate 
with the current active image.

This command invokes Custom Palette Dialog, will allows users to choose how the color table
and palette associated with current image is to be modified.

topic explains the Edit menu's Custom Palette command.

This version implement the "Paste Palette" command through the Custom Conversion and 
Dithering command under the Transform Menu.

__________________________________________
Related topics:

Transform : Custom Conversion and Dithering 
Custom Dithering Dialog 

Custom Palette Dialog    

Toolsbox : Palette 

The Palette Window 



Edit Merge Two Image Command

This command invokes "Merge Two Image Dialog" to allow users to choose direction for 
which the images are merged.

__________________________________________
Related topics:

Overview : Merge two image Basic 
Merge Two Image Dialog



Edit Stitch Window Command

After this command has been executed, users will be instructed on how to select the 
stitching and the base image on the status line. Users specify image selection by clicking on 
the image itself or the reduced version of the image in    <Reduced Image> window.    If 
current active window is the window for currently active image, it become the base image.

After making the selection, Users will enter the mode of operation for stitching image. In this
mode, users will have the freedom moving the image to any place they want. Furthermore, 
they can make a lot of adjustment to fine tune the operation or select a lot of options, 

including select background color (thru Toolsbox : Palette  which in turn invoke Palette 
Select Dialog ), restart another stitch operation under new circumstances, changing which 
image to be base image or stitching image, etc.

Users can also temporarily halt the operation and do other operation, perhaps preparing 
another stitch operation and then return to do the stitch operation again.

__________________________________________
Related topics:

Overview : Stitch Image Basic 



Edit Stitch Clipboard Command

This command allows users to stitch images between a base image and image from 
clipboard. If necessary, users will be instructed on how to select base image on the status 
line. Users specify image selection by clicking on the image itself or the reduced version of 
the image in    <Reduced Image> window. If current active window is the window for 
currently active image, it' become the base image.

After making the selection, Users will enter the mode of operation for stitching image. In this
mode, users will have the freedom moving the image to any place they want. Furthermore, 
they can make a lot of adjustment to fine tune the operation or select a lot of options, 

including select background color (thru Toolsbox : Palette  which in turn invokes Palette 
Select Dialog ), restart another stitch operation under new circumstances, changing which 
image to be base image or stitching image, etc.

Users can also temporarily halt the operation and do other operation, perhaps preparing 
another stitch operation and then return to do the stitch operation.

__________________________________________
Related topics:

Overview : Stitch Image Basic 
Edit : Copy from Clipboard    



Edit Resolution Command

This command allow users change current image's resolution. It invokes "resolution Setting 
Dialog" to accomplish this.

__________________________________________
Related topics:

Resolution Setting Dialog



Edit Capture to Clipboard Command

This command will capture portion of the screen to the    clipboard. 

After users select this command, a Capture    to clipboard dialog will be displayed. 

Users can then rearrange the desktop to have the desired appearance, and push on the 
or 

.button to proceed or abort the operation, respectively.

If  button is pushed, the cursor will be changed to cross-hair shape 
 to signal users to start the capturing operation. Portion of the screen (a rectangle) can be 

selected by anchoring or specifying the upper left corner by pushing down the left mouse 
button. Users then drag mouse until the desired rectangle is specified (color of portion of the
screen selected will be inverted). Users signal the completion of the selection process by 
releasing the left mouse button.

After users complete the selection process, capturing operation will be carried out.
After users complete the selection process, the clipboard contents will contain the captured 
image of the rectangular selected area. 

__________________________________________
Related topics:

Overview : Capture Image Basic 
Edit : Copy to Clipboard    



Edit Capture to Window Command

This topic explains the Edit menu's Capture to Window command.
This command will capture portion of screen to the clipboard. 

After users select this command, a Capture    to window dialog will be displayed. 

Users can then rearrange the desktop to have the desired appearance, and push on the 
or 

.button to proceed or abort the operation, respectively.

If  button is pushed, the cursor will be changed to cross-hair shape 
 to signal users to start the capturing operation. Portion of the screen (a rectangle) can be 

selected by anchoring or specifying the upper left corner by pushing down the left mouse 
button. Users then drag mouse until the desired rectangle is specified (color of portion of the
screen selected will be inverted). Users signal the completion of the selection process by 
releasing the left mouse button.

After users complete the selection process, a new window will be created with captured 
image of the rectangular selected area. 

__________________________________________
Related topics:

Overview : Capture Image Basic 
Edit : Paste from Clipboard    



Edit Create New Image Command

This topic explains the Edit menu's Create New Image command.

__________________________________________
Related topics:



Edit Duplicate Image Command

This command duplicates the current active image by copying it to a new window.
__________________________________________
Related topics:



Edit Trim Image Command

This command trim unwanted portion of the current active image.

Users can either    drag mouse or use keyboard (arrow keys) to defined    selected rectangle . 
For example, users drag mouse to define selected rectangle . After the initial selection, users
can further use arrow keys to make further adjustment. Alternatively, users can use only 
arrow keys selected rectangle without using mouse.

RIGHT ARROW    -- move left side of selected rectangle to the right.
LEFT ARROW    -- move right side of selected rectangle to the left.
UP ARROW    -- move bottom of selected rectangle upward.
DOWN ARROW    -- move top of selected rectangle downward.

If [SHIFT] keys and ARROW KEY are pressed at the same time, the boundary of the    selected
rectangle is adjusted in reverse direction.

[SHIFT] - RIGHT ARROW    -- move left side of selected rectangle to the left.
[SHIFT] - LEFT ARROW    -- move right side of selected rectangle to the right.
[SHIFT] - UP ARROW    -- move bottom of selected rectangle downward.
[SHIFT] - DOWN ARROW    -- move top of selected rectangle upward.

If the [CONTROL] key is also being pressed at the same time, it will make the selected 
rectangle adjustment proceed FASTER.

After the FINAL selected rectangle has been defined, users can either click on  button or
press on the [RETURN] key to perform the trim image operation. Users cancel can the 
operation by clicking on on 

 button on the status line.

        OK    Perform trim image operation.
        Cancel exit from trim image. 

__________________________________________
Related topics:

 Toolsbox : Rectangle : 
    CopyRect    



Option Menu

          OptionMenu allow users to perform miscellaneous setting related to preference, 
performance, display, as well as toolsbox, etc.

Profile    Various setting and user preferences.
Display Option Bitmap rendition and palette usage.
Pattern Selection    Pattern used for some operations.
Brush Selection    Brush shape and size selection.
Line Selection    Line style selection (for drawing tools).
Show Dithered Image    Show dithered or original version.
Create Dithered Image Create dithered version of current active image.
Begin Scan (Old Logitech) Scan image into a new window. (should use File : Acquire instead)
Scan Setup (Old Logitech) Setup for Logitech Scanner (should use File : Select Source 
instead)
Expert Mode    Turn expert mode on and mode.
Image Based Processing    Image based processing.
Document Based Processing    Document based processing.
__________________________________________
Related topics:



Option Profile Command

This command allows users to set a lot of options concerning memory usage, to convert 
input image to grayscale, show / hide rulers, set unit of measurements, etc.

It invokes Profile Setting Dialog to do the job.

If the current window is that of the editing image, the option will be local; otherwise, if the 
current window is the    <Reduced Image> window, the setting will be global.

__________________________________________
Related topics:

Profile Setting Dialog 



Option Palette Usage Command

This topic explains the Option menu's Palette Usage command.

__________________________________________
Related topics:

Palette Usage Dialog 

Toolsbox : Palette 

The Palette Window 



Option Display Option Command

This command allow sophisticated users to better fine tune the display method. If display 
method is "bitmap", faster performance may be achieved, but may use up more memory in 
some cases. (e.g. In Profile Setting Dialog, users choose "Memory DIB" option)

For users with plain old VGA card, i.e. VGA card which does not provide palette manager 
support, and typically only supports 16 colors, another option is available to control how to 
support the window palette.

__________________________________________
Related topics:

Option : Profile 
Profile Setting Dialog 
Display Option Dialog 

Toolsbox : Palette 

The Palette Window 



Option Expert Mode Command

This command enables users to switch between expert or novice mode. When in an expert 
mode, fewer hints or guidelines are provided.

__________________________________________
Related topics:



Option Pattern Background Command

This command allows users to create a customized pattern which may be used latter by 
some operations, usually as background pattern of the resulting image.
-- Not yet implemented --

__________________________________________
Related topics:

Pattern Select Dialog 



Option Brush Selection Command

This command allows users to create customized pattern brush to be used in various 
operation.

__________________________________________
Related topics:

Brush Shape and Size Dialog



Option Line Selection Command

This command allows users to create customized line style to be used in various operation.

__________________________________________
Related topics:

Line Style Select Dialog



Option Show Dithered Command

This command allows users to switch between displaying dithered version or unditherred 
version of the image.

This program will automatically create a dithered version of the image for 24-bits true color 
image.
__________________________________________
Related topics:



Option Create Dithered Command

This command will create a dithered version of the active image.

__________________________________________
Related topics:



Option Image Based Command

Change to Image Based Processing.

__________________________________________
Related topics:

Option Menu : Document Based Processing    .



Option Document Based Command

Change to Document Based Processing.

__________________________________________
Related topics:

Option Menu : Image Based Processing    .



Option Move Ruler Command

This topic explains the Option menu's Ruler command.

__________________________________________
Related topics:



View Menu

                            This is a View Menu.

Fit Window    Resize image if necessary to fit in window.
Actual size    Actual size for current setting. (unit used)
Zoom In    Zoom in, magnify by two fold.
Zoom Out    Zoom out, scale down by a half.
Image Info    Information on current image.
System Info    Information for system setting, display, etc.
Hide/Show Reduced Image    Show / hide window.
Hide/Show Ruler    Show / hide ruler.
Show Toolsbox    Show / hide toolsbox icons.
Show Status Line      Show / hide status line.

__________________________________________
Related topics:



View Menu : Hide/Show Ruler Command

This command will show or hide ruler.

__________________________________________
Related topics:



View Menu : Fit Window

This command will scale image if necessary so that the whole image can fit in the size of 
current active window.

__________________________________________
Related topics:

View : Fit Window    Resize image if necessary to fit in window.
View : Actual size    Actual size for current setting. (unit used)
View : Zoom In    Zoom in, magnify by two fold.
View : Zoom Out    Zoom out, scale down by a half.



View Menu : Actual Size

This command restores the image to original size.

__________________________________________
Related topics:

View : Fit Window    Resize image if necessary to fit in window.
View : Actual size    Actual size for current setting. (unit used)
View : Zoom In    Zoom in, magnify by two fold.
View : Zoom Out    Zoom out, scale down by a half.



View Menu : Zoom In

This command magnifies the current display size of the current active image by two fold.

__________________________________________
Related topics:

View : Fit Window    Resize image if necessary to fit in window.
View : Actual size    Actual size for current setting. (unit used)
View : Zoom In    Zoom in, magnify by two fold.
View : Zoom Out    Zoom out, scale down by a half.



View Menu : Zoom Out

This command reduces the current display size of the current active image by two fold.

__________________________________________
Related topics:

View : Fit Window    Resize image if necessary to fit in window.
View : Actual size    Actual size for current setting. (unit used)
View : Zoom In    Zoom in, magnify by two fold.
View : Zoom Out    Zoom out, scale down by a half.



View Menu : Image Info

This command displays information that may be helpful about current active image.

This command invokes Image Info Dialog which display information such as image type, file 
format, number of colors, image width, image height, resolution, etc.

__________________________________________
Related topics:

Image Info Dialog 
View : System Info    



View Menu : System Info

This command displays information about the Windows system and hardware information.

__________________________________________
Related topics:

System    Info Dialog 
View : Image Info 
View [Document Based] : Document Info 



View Menu : Show / Hide Reduced Image

This command allows users to control the visibility of the <Reduced Image>.    

__________________________________________
Related topics:



View Menu : Show Tools box

This command allows users to control whether to show or hide the toolsbox icons which will 
be located on the left hand edge of the program window if they are visible.

__________________________________________
Related topics:



View Menu : Show Status Line

This command allows users to control whether to show or hide the Status Line located at the
bottom of the window.

__________________________________________
Related topics:



View Menu : Show Ruler

This command will show or hide ruler.

__________________________________________
Related topics:



Show Pixel Ruler
                                  Show Pixel Ruler.

__________________________________________
Related topics:



Scan Menu

                            This is a Scan Menu.

Begin Scan
Scan Setup
__________________________________________
Related topics:



Begin Scan

This command will allow users to begin scan image into a new window if a scanner is 
attached to the system.

__________________________________________
Related topics:

File : Acquire    
File : Select Source 



Scanner Setup

This command invokes scanner setup dialog box.

__________________________________________
Related topics:

File : Acquire    
File : Select Source 



Transform Menu

                            Operations provided under this menu allow users to execute commands which
transform image geometrically and convert image to grayscale and dithering. 

Flip Horizontal        Flip the image horizontally.
Flip Vertical        Flip the image vertically.
Rotate Right        Rotate image clockwise 90 degree.
Rotate Left        Rotate image counter-clockwise 90 degree.
Rotate Image        Rotate image at specified angle.
Deskew        Rotate image to re-adjust horizontal axis of the image.
Scale        Scale the image or rectangular selected area of the image.
Convert to Graysvale        Convert current active image to grayscale.
Convert to 4 Bits Graysvale        Convert current active image to 4 bits grayscale.
Convert to 8 Bits Graysvale        Convert current active image to 8 bits grayscale.
Convert to 8 Bits Color    Convert current active image to 8-bits (256 color indexed) image.
Convert to 24 Bits Color    Convert current active image to 24-bits true color image.
Custom Conversion and Dithering        Convert image using dithering technique and custom 
palette.
__________________________________________
Related topics:



Transform Menu : Flip Horizontal

This command flips the current active image horizontally.

__________________________________________
Related topics:



Transform Menu : Flip Vertical

This command flips the current active image vertically.

__________________________________________
Related topics:



Transform Menu : Rotate Right

This command rotates the current active image to the right by 90 degree.

__________________________________________
Related topics:



Transform Menu : Rotate Left

This command rotates the current active image to the left by 90 degree.

__________________________________________
Related topics:



Transform Menu : Rotate Image

This command allows users to rotate the current active image to any angle or direction they 
specified.

It invoke Rotate Image Dialog which users can specify    the desired angle of rotation.

__________________________________________
Related topics:

Rotate Image Dialog
Transform : Deskew    



Transforn Menu : Deskew

After this command has been initiated, users drag mouse at any location on the active 
image, for which a rectangle with a diagonal line will be displayed. The diagonal line will be 
the horizontal axis of the transformed image if users decided to proceed with the operation.

Users then either click on the  or 
.button on the status line to proceed or abort the operation, respectivelly..

__________________________________________
Related topics:

Transform : Rotate Image    
Overview : Deskew Image Basic 
Deskew Image in Progress 



Transforn Menu : Scale

This command will invoke Scale Image Dialog which allows users to select on many options. 
If users want to scale just a selected rectangle of the image, the command will be redirected

to Toolsbox : Rectangle .

If users decide to scale the whole image, they can specify the scaled version of the image by
drag mouse on the active image to get the desired size. Then, they can either click on the

 or 
.button on the status line to proceed or abort the operation, respectively..

__________________________________________
Related topics:

Scale Image Dialog
Overview : Scale Image Basic    

Toolsbox : Rectangle  
Overview : Scale Image Basic 
Scale Image in Progress 



Transform Menu : Convert to Grayscale

Convert to grayscale with the same number of bits per pixel as the current active image.

__________________________________________
Related topics:

Dialog Box : Custom Dithering Dialog

Transform : Convert to 4 Bits Graysvale    
Transform : Convert to 8 Bits Graysvale    
Transform : Convert to 8 Bits Color    
Transform : Convert to 24 Bits Color 
Transform : Custom Conversion and Dithering    



Transform Menu : Convert to 4 Bits Grayscale

Convert to 4 bits per pixel grayscale.

__________________________________________
Related topics:

Dialog Box : Custom Dithering Dialog 

Transform : Convert to Graysvale    
Transform : Convert to 8 Bits Graysvale    
Transform : Convert to 8 Bits Color    
Transform : Convert to 24 Bits Color 
Transform : Custom Conversion and Dithering    



Transform Menu : Convert to 8 Bits Grayscale

Convert to 8 bits per pixel grayscale.

__________________________________________
Related topics:

Dialog Box : Custom Dithering Dialog 

Transform : Convert to Graysvale    
Transform : Convert to 4 Bits Graysvale    
Transform : Convert to 8 Bits Color    
Transform : Convert to 24 Bits Color 
Transform : Custom Conversion and Dithering    



Transform Menu : Custom Conversion and Dithering

This command invokes the Custom Dithering Dialog Box which allows users to select from a 
list of dithering techniques suitable dithering method to convert the image. Users can also 
choose some optimized or customized set of palette for the image.

__________________________________________
Related topics:

Toolsbox : Palette 

The Palette Window 
Dialog Box : Custom Dithering Dialog

Transform : Convert to Graysvale    
Transform : Convert to 4 Bits Graysvale    
Transform : Convert to 8 Bits Graysvale    
Transform : Convert to 8 Bits Color    
Transform : Convert to 24 Bits Color 



Transform Menu : Convert to 24 Bits True Color

Gray Scale dithering using 4 bits per pixel.

__________________________________________
Related topics:

Dialog Box : Custom Dithering Dialog
Transform : Convert to 8 Bits Color    
Transform : Convert to 24 Bits Color 
Transform : Custom Conversion and Dithering    
Transform : Convert to Graysvale    
Transform : Convert to 4 Bits Graysvale    
Transform : Convert to 8 Bits Graysvale    



Transform Menu : Convert to 8 Bits (256 Color indexed)

Gray Scale dithering using 8 bits per pixel.

__________________________________________
Related topics:

Dialog Box : Custom Dithering Dialog
Transform : Convert to 8 Bits Color    
Transform : Convert to 24 Bits Color 
Transform : Custom Conversion and Dithering    
Transform : Convert to Graysvale    
Transform : Convert to 4 Bits Graysvale    
Transform : Convert to 8 Bits Graysvale    



Process Menu

                            Commands under this menu provide users with    a wide range of image 
processing operations. Users can use the basic operations provided. However, experienced 
users may want to customized the operation to be able to more precisely perform operations
they want by choosing the advanced or custom options.

Brighten            Default image brightening. 
Darken            Darken image using default setting. 
Equalize            Equalize image using default setting. 
Smooth            Smoothen image using default method. 
Negate            Invert the image.
Threshold            Convert image according to intensity threshold.
Custom Image Filtering            Predefined and user defined filter.
Tone and Color Balance            Customized tone adjustment.
Interactive Equalization            Customized equalization.
Special Contrast Control            Specialized contrast control method.

__________________________________________
Related topics:

Overview : Image processing    



Process Menu : Brighten

This command brightens the image by some predefined amount. How the operation is being 
done depending on whether it modifies the image's color table directly or not. 

Option to modify color table or not can be controlled by checking un-checking on the 
checkbox controlling this feature in the Profile Setting Dialog. 
The dialog is invoked when choosing the Profile command on the Option Menu. 

__________________________________________
Related topics:

Process : Tone and Color Balance 
Process : Darken    
Option : Profile    



Process Menu : Darkening

This command darkens    the image by some predefined amount. How the operation is being 
done depending on whether it modifies the image's color table directly or not. 

Option to modify color table or not can be controlled by checking un-checking on the 
checkbox controlling this feature in the Profile Setting Dialog. 
The dialog is invoked when choosing the Profile command on the Option Menu. 

__________________________________________
Related topics:

Process : Tone and Color Balance 
Process : Brighten 
Option : Profile    



Process Menu : Equalize (default contrast)

This command equalizes the image by some predefined method. Currently, it is 
implemented as if non-linear equalization is selected in the Interactive equalization 
technique.

Aside from the equalization concept itself, how the operation is being done depending on 
whether it modifies the image's color table directly or not. 

Option to modify color table or not can be controlled by checking un-checking on the 
checkbox controlling this feature in the Profile Setting Dialog. 
The dialog is invoked when choosing the Profile command on the Option Menu. 

__________________________________________
Related topics:

Option : Profile    

Process : Interactive Equalization      
Process : Special Contrast Control      



Process Menu : Smooth

This command smoothens the current active image.

For other image processing operation as well as image smoothing techniques choose 
Custom Image Filtering technique.

__________________________________________
Related topics:

Process : Custom Image Filtering    



Process Menu : Negate

This command inverts the currently active image.

How the operation is being done depending on whether it modifies the image's color table 
directly or not. 

Option to modify color table or not can be controlled by checking un-checking on the 
checkbox controlling this feature in the Profile Setting Dialog. 
The dialog is invoked when choosing the Profile command on the Option Menu. 

__________________________________________
Related topics:



Process Menu : Threshold

This command invokes the Thresholding Dialog which allows users to select a threshold 
value and how the colors above and below this threshold value are modified.

How the operation is being done depending on whether it modifies the image's color table 
directly or not. 

Option to modify color table or not can be controlled by checking un-checking on the 
checkbox controlling this feature in the Profile Setting Dialog. 
The dialog is invoked when choosing the Profile command on the Option Menu. 

__________________________________________
Related topics:

Thresholding Dialog



Process Menu : Custom Image Filtering

This command allows users to fine tune the image processing operation and even design the
operation themselves.

It invokes Custom Image Filtering Dialog which present users with assortments of predefined
filters groups to carry out different operation. Users can also define the filter operation 
themselves and save the result for latter uses.

__________________________________________
Related topics:

Custom Image Filtering Dialog
Process : Smooth            Smoothen image using default method. 



Process Menu : Interactive Equalization

This command invokes Interactive equalization Dialog which allows users to customize the 
operation and use equalization method that best suit they need.

__________________________________________
Related topics:

Interactive Equalization Dialog

Process : Equalize (default)    
Process : Special Contrast Control      



Process Menu : Tone and Color Balance

This command invokes Tone and Color Balance Dialog which allows users to customize the 
operation and modify the image intensity in a way that best suit their need.

__________________________________________
Related topics:

Tone and Color Balance Dialog 

Process : Brighten            Default image brightening. 
Process : Darken            Darken image using default setting. 



Process Menu : Specialize Contrast Control

Not yet implemented.

__________________________________________
Related topics:

Custom Contrast Dialog

Process : Equalize (default)    
Process : Interactive Equalization      



Window Menu 

Window management commands., set the windows arrangement, etc.

Tile Window    Arrange windows in a non-overlapped manner.
Cascade Window    Arrange windows in a overlapped manner.
Arrange Icon    Re-arrange minimized windows icons.
Close All Window    Close all windows, associated images.
__________________________________________
Related topics:



Window Menu : Tile Window

Tile windows. 
__________________________________________
Related topics:



Window Menu : Cascade Window

Cascade windows.
__________________________________________
Related topics:



Window Menu : Arrange Icons

Arrange icons. 
__________________________________________
Related topics:



Window Menu : Close All Window

Close all active image windows.
__________________________________________
Related topics:



Help Menu

                            This is a Help Menu.

Help on Help    How to use help.
Help Index    Master index of help topics available.
Help Topics    Overview of help arranged by topics.
Help on Keyboard    How to use keyboard and mouse.
Help on Glossary    Terms useful to understand operations.
About this Program    Copyright and other information.
__________________________________________
Related topics:



Help Index

Help Index.
__________________________________________
Related topics:



Help on Help

Help on Help.
__________________________________________
Related topics:



Help Topics

Help Topics.
__________________________________________
Related topics:



Help on Keyboard

Help on Keyboard.
__________________________________________
Related topics:



Help Glossary

Help Glossary.
__________________________________________
Related topics:



About Dialog

About this program. 
__________________________________________
Related topics:



Toolsbox

Toolsbox offers assortments of operations on the active image. These include editing, 
customizing, adding text, modifying attributes as well as appearances of text to be added to 
the image, selecting fonts for text input, palette control, etc.

Toolsbox : Palette    Select foreground and background color.

Toolsbox : Fonts    Select font type and size.

Toolsbox : Text    Customize text added to the active image.

Toolsbox : Rectangle    Selection and operations on selected rectangle.

Toolsbox :    Pencil    Pixel editing for the image.

Toolsbox : Eraser    Replace portion of the image with current brush.

Toolsbox : Drawing    Drawing with current line style.

Toolsbox : Floodfill    Fill area with    foreground color.

Toolsbox : Image Patching    Define and move area under geometric shape or freehand 
drawing and patch to other part of the image.

__________________________________________
Related topics:



 Toolsbox : Text Input

This topic explains steps in how to input text, edit text, and how to customize or adjust text 
line(s) to have exact appearance that users want. 

Users can input and edit the text line(s) that have already been entered, move to the 
desired location, or resize the text line(s) to the exact size that the users want. They can 
also change various display attributes such transparency, or have characters packed closer.

Users can know whether some of the operations are in progress by observing the cursor 
shape. an I-beam  means that users can input text, a hand-shaped cursor 

 means users can move the text line to other location. A resize-cursor    

 means users can    resize the text line.

All text lines entered are still not committed to the image until users committed the text 
line(s) by clicking on the  or 

 button.

Users select operations they want by Clicking on the push-button on the status line. 

Some commands can be done by clicking the button while a <SHIFT>key is being pressed to
give alternate meaning, usually doing something in reverse direction. 

Some commands can be done by clicking the button while a <Cntl>key is being pressed to 
give alternate meaning. e.g. when setting background color and foreground color , the 
commands will cycle thru the color palette faster.

Users can also set the foreground color or background color of the current textline by 

invoking the Palette Select Dialog thru the  Toolsbox : Palette .

Usually users signal when the operation is completed by pushing on the [RETURN] key.
All command have equivalent keystroke combination as shown along-side with explanation 
text below.

For more information, Click on the topic of interest listed as follow: 

        OK    write all lines of text.    <Ctl><ENTER>

        Cancel exit from text toolsbox.    

        Write    write current line of text. <SHIFT><ENTER>

-     Transparency <Ctl><SP>

        Background text color. <ArrowUp>, <ArrowDn>



        Foreground    text color. <PgUp>, <PgDn>

        Move or resize text    <End> , or <SHIFT><SP>

-     Adjusted / Original Stretch / restore text .    <SHIFT><END> / <SHIFT><HOME>

-<SHIFT>         TAB move to next (previous) line. 

-         Pack    Pack or unpack text string. <Ctl><HOME> / <Ctl><END>

__________________________________________
Related topics:

Text Editing Basic 

 Toolsbox : Palette 

 Toolsbox : Text 

 Toolsbox : Drawing    



 Toolsbox : rectangle

This topic explains the operations for selecting a rectangle on an image and various 
operations to be operated on or using the image under selected rectangle .

To start, select a rectangle,    drag mouse    on the desired area, and release the mouse 
button to complete the selection process. After the initial selection, users can change the 
location or size of the selected rectangle .

There are two modes of operation:
          1. Operation ON the selected rectangle. Users enter this mode by clicking on the

 button. Operations under this mode include process area selection itself, cutting the 
area from the image (click on 

), and copy the area onto a new window (click on 
). A double click on the left mouse button will reset the selected rectangle.

          2. Operation USING the selected rectangle. Users enter this mode by clicking on the
 button.                            Operations under this mode include scaling (click on 
 button), and stitch the selected rectangle    (which may have been    resized) to any 

location of the image (click on 
 button).

Both mode of operations include operations which allows users to move or resize the 
rectangle involved. A hand-shaped cursor  indicates that users can move the rectangle to
other location, while resize-cursor    

 means users can    resize the rectangle by drag mouse on the active image.

        OK    Stitch at current location.

        Cancel exit from the toolsbox.

        CopyRect    copy selected rectangle.

        CutRect cut selected rectangle.

        Rectangle selecting an area.

        Resize area move or resize selected rectangle.

        Scale area scale image under selected rectangle.

        Setup options for the toolsbox.

__________________________________________
Related topics:



Stitch Image Basic 
Scale Image Basic
Trim Image 



Toolsbox : Fonts

This command invokes Fonts Setup Dialog    and allows users to choose different font type, 
size, and attributes to be used for text editing. 

__________________________________________
Related topics:

Fonts Setup Dialog 
Toolsbox : Text 



Toolsbox : Palette

Palette tools allows users to get a detailed picture of all colors of the palette of the current 
working image. Users can then select foreground and background colors easily.

Basically, the tools invokes Palette Select Dialog which presents colors of the current image's
palette, along with current image's foreground color and background color 

Users click on the foreground color select or    background color select rectangle on the 
dialog box to indicate which one they want to set, and then click on one the color in the 
current palette, box to make the color selection.

When the dialog is invoked while users are editing the image under  Toolsbox : Text 
or 

 Toolsbox : Drawing , 

 Toolsbox :    Pencil , this dialog can be used to set the foreground color or background color 
of current textline , current drawing , or current pixel group , respectively.

__________________________________________
Related topics:

Palette Select Dialog

 The Palette Window 

 Toolsbox : Text 

 Toolsbox : Drawing    

 Toolsbox :    Pencil    



Toolsbox : Palette Usage

                                  Palette Usage toolsbox.

__________________________________________
Related topics:

Toolsbox : Palette 
The Palette Window 



 Toolsbox : Pencil

This topic explains steps on how to use the pixel editing tools. How to adjust dot shape and 
size, move , resize, set or change the foreground color or background color of the    current 
pixel group .

Users drag mouse on the desired location of the image to make inital drawing. After this 
initial drawing, other set of dots can still be added util users press the [RETURN] key to 
signal that a logical pixel group has been formed. All these pixels together become current 
pixel group (Users can still modify this current pixel group again by pressing the [Space 
Bar] ).

If several logical pixel groups has been formed, users can know which is the current pixel 
group by clicking on the  button, the color of the current pixel group will be inverted. 
Users can then drag mouse to move this current pixel group and press the [RETURN] key 
return to normal pixel editing operation.

Users can also know whether some of the operations are in progress by observing the cursor
shape. A hand-shaped cursor  means users can move the drawing to other location. 
A resize-cursor    

 means users can    resize the drawing. (Notes: resize operation may still be disabled 
for current version). 

All pixel group(s) entered are still not committed to the image until users committed the 
them to the image by clicking on the  or 

 button.

Users select operations they want by Clicking on the push-button on the status line. Some 
commands can be done by clicking the button while a <SHIFT>key and/or a <Cntl>key is 
being pressed. 

Usually, a <SHIFT>key is being pressed to give alternate meaning that something is being 
done in reverse direction, for examples, when setting the background color and foreground 
color of the current pixel group . On the other hand, a <Cntl>key is used to indicate that 
users want to move thru the color palette faster.

Users can also set the foreground color or background color of the current pixel group by 
invoking the Palette Select Dialog thru the  Toolsbox : Palette .

Usually users signal when the operation is completed by pushing on the [RETURN] key.

The shape and size of the pixel drawn are controlled by current brush, which can be set from
Option menu : Brush Selection    (as opposed to  Toolsbox : Drawing which can be set 
from Option menu : Line Selection ).

For more information, Click on the topic of interest listed as follow: 

        OK    write all pixel group .    <Ctl><ENTER> 



        Cancel exit from pencil toolsbox. 

        Write    write    current pixel group . <SHIFT><ENTER> 

-     Transparency <Ctl><SP> 

        Background color.    <UpArrow>, <DnArrow> 

        Foreground color. <PgUp>, <PgDn> 

        Move or resize    current pixel group <End> 

    Erase pixel(s) of    current pixel group 

-<SHIFT>         TAB move to next (previous)    current pixel group. 

-     Adjusted / Original Stretch / restore current pixel group . <SHIFT><END> / 
<SHIFT><HOME>

__________________________________________
Related topics:

Option menu : Brush Selection    
Option menu : Line Selection .

 Toolsbox : Palette 

 Toolsbox : Eraser    

 Toolsbox : Drawing    

 Toolsbox : Image Patching    



 Toolsbox : Eraser

Currently, its implemented as Toolsbox :    Pencil    .

__________________________________________
Related topics:

Option menu : Brush Selection    
Option menu : Line Selection .

 Toolsbox : Palette 

 Toolsbox :    Pencil    

 Toolsbox : Eraser    

 Toolsbox : Drawing    

 Toolsbox : Image Patching    



 Toolsbox : Drawing

This topic explains steps on how to use the drawing tools for lines, rectangle, circle, etc. with
current line style, line width, foreground, and background colors. How to customize or adjust 
the drawings to have exact appearance that users wants. 

The default state of drawing is freehand drawing. Users can also enter geometric drawing 
mode by first clicking on the , 

, 
 or 
 button to select the geometric shape to draw, Then drag mouse on the desired 

location of the image. To exit from geometric drawing mode (and hence return to the default
state of freehand drawing), press the [ESC] key. Press the [RETURN] key also return to the 
operation mode default state of freehand drawing. 

If several drawings have been made, users can know which drawing is the active current 
drawing by clicking on the  button, the color of the active current drawing will be 
inverted. Users can then drag mouse to move or resize this active current drawing or press 
the [RETURN] key to resume another drawing operation. (resizing may be available only for 
geometric drawings)

Users can also know whether some of the operations are in progress by observing the cursor
shape. A hand-shaped cursor  means users can move the drawing to other location. 
A resize-cursor    

 means users can    resize the drawing.

All drawings entered are still not committed to the image until users committed the 
drawing(s)    by clicking on the  or 

 button.

Users select operations they want by Clicking on the push-button on the status line. Some 
commands can be done by clicking the button while a <SHIFT>key and/or a <Cntl>key is 
being pressed. 

Usually, a <SHIFT>key is being pressed to give alternate meaning that something is being 
done in reverse direction. When setting background color and foreground color , for 
example, a <Cntl>key is used to indicate that users want to move thru the color palette 
faster.

Users can also set the foreground color or background color of the current drawing by 
invoking the Palette Select Dialog using thru the  Toolsbox : Palette .

Users can edit or change almost all of the drawing and display attributes after the initial 
drawing. They can also move or resize the current active drawing figure to almost any 
location and any size they want by click on the , 

, 
, 

, 



, 
    button.

Usually users signal when the operation is completed by pushing on the [RETURN] key.

Most command have equivalent keystroke combination as shown along-side with 
explanation text below.

For more information, Click on the topic of interest listed as follow: 

        OK    write all drawings.    <Ctl><ENTER>

        Cancel exit from drawing toolsbox. 

        Write    write current active drawing. <SHIFT><ENTER>

-     Transparency <Ctl><SP>

        Background color.    <UpArrow>, <DnArrow>

        Foreground color. <PgUp>, <PgDn>

        Move or resize drawing    <End>

-<SHIFT>         TAB move to next (previous) drawing. 

    Solid draw    Fill area with the drawing's border color. <SHIFT><SP>

    Draw frame only    Do not fill the area inside the drawing. <SHIFT><SP>

    Draw line    with current line width and line style.

    Draw rectangle    with current line width and line style.

    Draw circle    with current line width and line style.

    Draw rounded rectangle    with current line width and line style.

    Fill area with current foreground color. <SHIFT><SP>

notes:    Pressing <SHIFT><SP> will cycle through three operations which correspond to 
clicking on one of the three buttons on the status line, i.e. , 

, or 
 .

__________________________________________
Related topics:

Option menu : Brush Selection    



Option menu : Line Selection .

 Toolsbox : Palette 

 Toolsbox :    Pencil    

 Toolsbox : Eraser    

 Toolsbox : Image Patching    



 Toolsbox : Area Fill (Floodfill) 

This topic explains steps on how to use the tools for filling area with current foreground 
color. 

User can specify area to be filled by clicking on that portion of the image. Furthermore, user 
can change the area fill color afterward. by invoking the Palette Select Dialog thru the

 Toolsbox : Palette .

If several areas have been filled, users can know which drawing is the current selected fill 
area by clicking on the  and return to area fill operation by press the [RETURN] key or
click at the 

 button. the color of the selected fill area will be inverted. 
(current version may disable this feature)

Users can also know whether some of the operations are in progress by observing the cursor
shape. A hand-shaped cursor  means users cannot fill new area at the moment.

All operation entered are still not committed to the image until users committed the filled 
area(s) by clicking on the  or 

 button.

Users select operations they want by Clicking on the push-button on the status line. Some 
commands can be done by clicking the button while a <SHIFT>key and/or a <Cntl>key is 
being pressed. 
Usually, a <SHIFT>key is being pressed to give alternate meaning that something is being 
done in reverse direction. e. g. setting background color and foreground color . A <Cntl>key 
is used to indicate that users want to move thru the something such as color palette faster.

Usually users signal when the operation is completed by pushing on the [RETURN] key.

Most commands have equivalent keystroke combination as shown along-side with 
explanation text below.

For more information, Click on the topic of interest listed as follow: 

        OK    commit all filled area to image.    <Ctl><ENTER>

        Cancel exit from area fill.    

        Write    write current active fill area to image. <SHIFT><ENTER>

-     Transparency show (identify) active fill area in inverted color. <Ctl><SP>

        Foreground    change fill area color. <PgUp>, <PgDn>

-<SHIFT>         TAB move to next (previous) filled area. 



__________________________________________
Related topics:



 Toolsbox : Image Patching

This topic explains steps on how to use the image patching tools to define a selected area 
(portion) of current image and move portion of the image under the selected area to patch it
to other part of the image. The selected area can be a rectangle, a circle, an irregular shape 
(freehand drawing), etc. After the initial drawing, users can also make further adjustment or 
customize the drawings to have the exact appearance that users wants. 

Users can make drawing by first clicking on the , 
, 
 or 
 button to select the geometric shape or irregular shape (free hand drawing) area. Then

drag mouse on the desired location on the image.

Users can edit or change almost all of the drawing and display attributes after the initial 
drawing. They can also move or resize the current active drawing figure to almost any 
location and any size they want. However, for irregular shape, the selected area can only 
moved. To edit the area's boundary, press the space bar, then drag mouse to change it's 
boundary. Press [RETURN] to resume another image patching operation.

If several area selections have been made, users can know which area is the current active 
area by clicking on the  button, the drawing color will be inverted. Users can then 
press [RETURN] to resume another area selection operation.

Users can also whether some of the operations are in progress by observing the cursor 
shape. A hand-shaped cursor  means users can move the drawing to other location. 
A resize-cursor    

 means users can    resize the drawing.

After users have defined the boundary of the area, users can then move this area to any 
location on the image by first click on the  button, and the drag mouse on the selected 
area to the desired location on the image.

All drawings entered are still not committed to the image until users committed the 
drawing(s)    by clicking on the  or 

 button.

Users select operations they want by Clicking on the push-button on the status line. Some 
commands can be done by clicking the button while a <SHIFT>key and/or a <Cntl>key is 
being pressed. 
Usually, a <SHIFT>key is being pressed to give alternate meaning that something is being 
done in reverse direction. When setting background color and foreground color , for 
example, a <Cntl>key is used to indicate that users want to move thru the color palette 
faster.

Users can also set the foreground color or background color of the current drawing by 
invoking the Palette Select Dialog using thru the 

 Toolsbox : Palette .

Usually users signal when the operation is completed by pushing on the [RETURN] key.



Most command have equivalent keystroke combination as shown along-side with 
explanation text below.

For more information, Click on the topic of interest listed as follow: 

        OK    commit all changes to the image.    <Ctl><ENTER>

        Cancel exit from drawing toolsbox.    

        Write    commit current selected area to the image. <SHIFT><ENTER>

-     Transparency <Ctl><SP>

        Background color.    <UpArrow>, <DnArrow>

        Foreground color. <PgUp>, <PgDn>

        Move or resize area selection    <End>

-<SHIFT>         TAB move to next (previous) selected area. 

 -Adjust area Adjust selected area.

    Free hand drawing    Select area by free hand drawing.

    Draw rectangle shape    

    Draw circle shape    

    Draw rounded rectangle shape    

    Put area Move the image under the selected area and put on specified location by drag 
mouse on the selected area. <SHIFT><SP>

__________________________________________
Related topics:

 Toolsbox :    Pencil    

 Toolsbox : Eraser    

 Toolsbox : Drawing    





Toolsbox : MoveText

                                  Move Text toolsbox.



Toolsbox : Copy Text

                                  Copy Text toolsbox.



Toolsbox : De-Select tools

                                  De-select tools toolsbox.



Glossary

clipboard      





Context Sensitive Topics

This Help system includes topics that you can call directly from the Helpex sample 
application. To get context-sensitive help from Helpex, press Shift+F1 and click on any 
element of the Helpex application window. You can also highlight any Helpex menu 
command using the keyboard and press F1 to get help on the command. Each topic has a 
unique context identifier, listed in the [MAP] section of the Help project file:





Menu commands [Document Based Processing]

System Menu      Minimize, maximize, close, restore, etc.
File Menu        Operations on document file, printer, etc.
Edit Menu      Operations which may modify or rearrange document.
Option Menu      Miscellaneous setting etc.
View Menu      Zoom in, zoom out, hide/show window.
Window Menu      Window management commands.
Help Menu      Accessing program and supporting help.

__________________________________________
Related topics:



File Menu [Document Based Processing]

The File menu includes commands that enable users to open and save files, establish a new 
workspace, print, setup printer, etc.

For more information, select one of the following item under the "File menu" command :

Restart Document      Restart a new document from scratch..
Open Document      Load HUBBLE document file from disk.
Merge Document      Load and merge HUBBLE document file from disk.
Save Document                  Save HUBBLE document file on disk.
Save Document As      Save HUBBLE document file on disk file with specified name.
Print Document      Print current document.
Print Setup      Choose printer, set options, and select port.
Update Screen      Repaint screen to eliminate tainted area.
Exit      Quit the program.
__________________________________________
Related topics:



File Menu : Restart Document Command

Restart a new document from scratch, This command also invokes    Document Page and 
Paragraph Format Dialog    to allow users to customize page size, resolution, paragraph 
spacing, margin, etc.

__________________________________________
Related topics:

File Menu : Open Document 
Option Menu : aragraph and Page Format 
Document Page and Paragraph Format Dialog Box



File Menu : Open Document Command

This command invokes File Open Dialog which lets users to select and open HUBBLE 
document files.

__________________________________________
Related topics:

File Menu : Restart Document 
File Menu : Merge Document    
Open Option Dialog



File Menu : Merge Document Command

This command invokes File Open Dialog which lets users to select and open HUBBLE 
document files.

Currently, it is implemented as File Menu : Open Document .
__________________________________________
Related topics:

File Menu : Restart Document 
File Menu : Open Document 
Open Option Dialog



File Menu : Print Document Command

This command let users print a document page.

Before actual printing is taking place, a Print Options Dialog is invoked to allow users to 
make any adjustment or customization for the printed output. These include paper margin, 
size of the printed document, etc. 

__________________________________________
Related topics:

Print Options Dialog
File : Print Setup    



File Menu : Save Document Command

This command save the currently working HUBBLE document pages. It invokes File Save 
Dialog which allow users to specify filename, file path (drive and directory) for HUBBLE 
document file.

At the moment, it is implemented as if the Save Document As    command.

__________________________________________
Related topics:

File Menu : Save Document As 
File Save Document Dialog



File Menu : Save Document As Command

This command save the currently working HUBBLE document pages. It invokes File Save 
Dialog which allow users to specify filename, file path (drive and directory) for HUBBLE 
document file.

__________________________________________
Related topics:

File Menu : Save Document 
File Save Document Dialog    



File Menu : Update Screen Command

This command will repaint every window which belong to the program to eliminate some 
possible tainted area resulting from various operation, or because some windows' color 
display are degraded due to palette changes, etc.

__________________________________________
Related topics:



Edit Menu [Document Based Processing]

The Edit menu includes commands that enable you to add, delete, change, move, or 
rearrange elements of a document page. These include paragraphs, image added, draings, 
customized text, etc.

For more information, select the Edit menu command name.

Undo Undo previous paragraph text change.
Find    Find paragraph text.
Change Text    Find and replace paragraph text.
Goto Previous Page    Go to the previous page.
Goto Next Page      Go to the next page.
Insert Document Page    Insert a new document page.
Delete Document Page    Delete current current document page.
Shift Crrent Page    Rearrange page sequence.
Delete/Shift Current Paragraph    delete move paragraph.
Reposition Image, Drawings, etc.    Rearrange elements added to the document.
Add Image To Document    Add image to the document.
Move/Resize/Delete/Name Image Added    Move/Resize/Resize bitmap image added to the 

document.
Encircle Word(s) to Highlight Draws an ellipse around a word under the cursor of the 

paragraph text.

__________________________________________
Related topics:



Edit Menu : Undo Command

Not yet implemented.

__________________________________________
Related topics:

Edit Menu : Find    
Edit Menu : Change Text    



Edit Menu : Find Command

Not yet implemented.

__________________________________________
Related topics:

Edit Menu : Undo    
Edit Menu : Change Text    



Edit Menu : Change Text Command

Not yet implemented.

__________________________________________
Related topics:

Edit Menu : Undo    
Edit Menu : Find    



Edit Menu : Goto Next Page Command

Users can also use Cntl+[PgUp] key to goto next document page for editing.

__________________________________________
Related topics:



Edit Menu : Goto Previous Page Command

Users can also use Cntl+[PgDn] key to goto previous document page for editing.

__________________________________________
Related topics:



Edit Menu : Insert Document Page Command

Add a new document page.
__________________________________________
Related topics:



Edit Menu : Delete Document Page Command

Users can also use Cntl+[Del]    key    to delete a document page.

__________________________________________
Related topics:



Edit Menu : Shift Crrent Page Command

Use Up/Down arrow keys to shift relative position of a document page. This command affects
the sequencing of the document pages. Use [ESC] key to return to    Default State for 
Document Based Processing .

__________________________________________
Related topics:



Edit Menu : Delete/Shift Paragraph Up / Down 

Use Up/Down arrow keys to shift relative position of a paragraph. Use [Del] key to delete 
current paragraph. Use [ESC] key to return to    Default State for Document Based Processing
.

__________________________________________
Related topics:



Edit Menu : Shift relative top-bottom arrangement of drawings, image added

Use Up/Down arrow keys to shift relative top-bottom arrangement of almost everything 
(document elements) added to the document except paragraph text. These include drawing,
customized text, bitmap images, etc.    Part of the document elements at the bottom of the 
arrangement may be covered (and hence invisible) by those on the top when displayed or 
printed.

Use [ESC] key to return to    Default State for Document Based Processing .

__________________________________________
Related topics:



Edit Menu : Add Image To Document Command

After users choose this command, click on selected image and then click on location on the 
document page.

__________________________________________
Related topics:

Edit Menu : Move/Resize/Delete/Name Image Added    



Edit Menu : Move/Resize/Delete/Name Image Added Command

This command allow users to delete, or adjust the size and location of the bitmap image 
added from Edit Menu : Add Image To Document command. Drag mouse to move or reized 
image added. Use [Del] key to delete.

If several bitmap images have been added to the HUBBLE document page, use [Tab] key to 
change the current selection. When the mouse cursor is above the selected image, the 
mouse cursor will change to a hand-shaped cursor.

Naming is still not implemented.

__________________________________________
Related topics:

Edit Menu : Add Image To Document    



Edit Menu : Encircle Word(s) to Highlight Command

This command enter the operation mode which allow users to draw an ellipse around a word
under the cursor of the paragraph text. Move the cursor to within the word to be encircled 
the press the [ENTER] key.

The color of current encircled ellipse can be change by clicking on the Toolsbox : Palette
. Users can also press on the [SPACE BAR] to cycle thru available colors of the color 

palette. Press [SPACE BAR] while the <SHIFT> is down while will cycle thru available colors 
of the color palette in the reverse direction.

Use [TAB] key to change current "encircled drawing". One way to know which "encircled 
drawing" is the current one is by pressing the [SPACE BAR], the color of the current 
"encircled drawing" will changed. Use <SHIFT>+[SPACE BAR] key to change back to the 
original color.

__________________________________________
Related topics:



Option Menu [Document Based Processing]

          OptionMenu allow users to perform miscellaneous setting related to preference, 
performance, display, as well as toolsbox, etc.

Profile Setting    Various setting and user preferences.
Paragraph and Page Format 
Brush Selection    Brush shape and size selection.
Line Selection    Line style selection (for drawing tools).
Image Based Processing    Image based processing.
Document Based Processing    Document based processing.
__________________________________________
Related topics:



Option Menu : Profile Setting Command

__________________________________________
Related topics:



Option Menu : Paragraph and Page Format Command

This command invokes Document Page and Paragraph Format Dialog    to set page layout, 
paragraph format, lmargin, etc.

__________________________________________
Related topics:

Document Page and Paragraph Format Dialog 



View Menu [Document Based Processing]

                            This is a View Menu.

System Info    Information for system setting, display, etc.
Document Info    Information on current HUBBLE document.
Fit Document to Window    
Actual size of Document    
Zoom Document In    Zoom in, magnify by two fold.
Zoom Document Out    Zoom out, scale down by a half.
ide/Show Document Ruler    Show / hide ruler.
Show Status Line      Show / hide status line.
Print Preview    Preview to of the document page to be printed.
Detail View    Bitmap view of the doccument page.

__________________________________________
Related topics:



View Menu : Fit Document to Window

__________________________________________
Related topics:
Fit Document to Window    
Actual size of Document    
Zoom Document In    
Zoom Document Out    



View Menu : Actual Size of Document

This command restores the image to original size.

__________________________________________
Related topics:
Fit Document to Window    
Actual size of Document    
Zoom Document In    
Zoom Document Out    



View Menu : Zoom Document In

__________________________________________
Related topics:
Fit Document to Window    
Actual size of Document    
Zoom Document In    
Zoom Document Out    



View Menu : Zoom Document Out

__________________________________________
Related topics:
Fit Document to Window    
Actual size of Document    
Zoom Document In    
Zoom Document Out    



View Menu : Document Info

__________________________________________
Related topics:

Image Info Dialog 
View : System Info    



View Menu : Show Status Line

This command allow users to control whether to show or hide the Status Line located at the 
bottom of the window.

__________________________________________
Related topics:



View Menu : Hide/Show Ruler Command

This command will show or hide ruler.

__________________________________________
Related topics:



View Menu : Print Preview Command

Print preview of the document page.

__________________________________________
Related topics:



View Menu : Detail View Command

This command show detail view.

__________________________________________
Related topics:



Operations on Document

Operations to be performed on document.
 
Encircle Word(s) to Highlight    
Select Image to Add    
Locate Where to Add Image    
Move/Resize Image Added    
Add Image Description    
Shift Current Paragraph Basic    
Shift Current Document Page    
Rearrange Drawings, Images Added    
Document Detail View    
Document Print Preview    

__________________________________________
Related topics:



Shift Current Document Page

__________________________________________
Related topics:

Edit Menu : Shift Crrent Page    



Document Print Preview

__________________________________________
Related topics:

View Menu : Print Preview 



Rearrange Drawings, Images Added 

__________________________________________
Related topics:

Edit Menu :Reposition Image, Drawings, etc.    



Document Detail View

__________________________________________
Related topics:

View Menu : Detail View 



Encircle Word(s) to Highlight

__________________________________________
Related topics:

Edit Menu : Encircle Word(s) to Highlight 



Move/Resize Image Added

__________________________________________
Related topics:

Edit Menu : Move/Resize/Delete/Name Image Added    



Select Image to Add

__________________________________________
Related topics:

Edit Menu : Add Image To Document    



Add Image Description

__________________________________________
Related topics:

Edit Menu : Move/Resize/Delete/Name Image Added    



Shift Current Paragraph Basic

__________________________________________
Related topics:

Edit Menu : Shift Current Paragraph    



Locate Where to Add Image

__________________________________________
Related topics:

Edit Menu : Add Image To Document    
Edit Menu : Move/Resize/Delete/Name Image Added    









Windows Keys
                                            Cursor Movement Keys
                                            Dialog Box Keys
                                            Editing Keys
                                            Help Keys
                                            Menu Keys
                                              System Keys
                                            Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
Pressing F1 also displays a Help topic on the selected    menu 
command, dialog box option, or system message.

SHIFT+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.



                                            Text Selection Keys





Glossary

 Clipboard    
 Current text line    
 Pixel group    
 Current pixel group    
 Reduced image    
 Drag mouse    
 Selected area    
 Foreground color    
 Background color    
 Current drawing    
 Line Style    
 Transparent    
 Opaque    
 Committed text    
 Committed drawing    
 Foreground select    
 Background select    
 Palette select    
 
 
 



 
Clipboard

An intermediate storage used as a place holder to transfer data in an application or between
applications.



Tranparent mode

One of the mode for displaying text lines and drawing tool's various drawings. The 
background rectangle of the text line or drawing is not show.



Opaque mode

One of the mode for displaying text lines and drawing tool's various drawings. The 
background rectangle of the text line or drawing is fill with that text line or drawing's 
background color.



Line Style

Line styles are attributes of a line used in the drawing toolsbox. These attributes include line 
width, whether the line is a solid line or not, etc..



Committed text

A text line which has been written to the image and become part of the image.



Committed 

Changes created by various tools in toolsbox such as text input or drawing(s) which has 
been made to become permanent part of the image.



Commit drawing

A drawing created by the drawing toolsbox which has been written to the image and become
part of the image.



Data Compression Method

data compression.



Foreground color select

Foreground color select rectangle.



Background color select

Background color select rectangle.



Current Palette

Current palette of the image.



Current text line

A text line which is available for editing, moving, and resizing.



Pixel group

A group of pixels which is drawn using pencil tools to form a logical manipulation unit.



Current pixel group

The current active group of pixels (a logical manipulation unit) drawn using pencil tools .



<Reduced Image> Window    
The reduced image window displays the corresponding reduced versions of the opened 
images. It can also used to select active window for various operations. users can also set 
various global variables when this window has focus. Other components of this window are

 The Palette Window and 

    The Tinytiny    Window . 



Drag mouse

Move the mouse while the left button is down.



Selected area

An area bounded by a rectangle, a circle, rounded rectangle, any geometric shape or free 
hand drawing, etc. which is used to identify portion of the image to be edited or processed.



Foreground color

Foreground color is the color for which a text line or drawing is displayed. Foreground color is
also used as fill color for area fill operation.



Background color

Background color is the color for a rectangle underneath a text line or drawing is displayed 
in certain mode of display.



Current drawing

A drawing which is available for editing, either moving or resizing.



 



Overview

Operations on image          Assortments of operations supported.
Operations on document          Operations on document supported.
Image processing    Transform and enhance image.
Using the program          How to the use program effectively.
File formats          Brief description of file formats.
Dialog boxes          Description of various dialog box.
The Status Line          Brief description of status line.
The <Reduced Image> Window    

 The Palette Window          Brief description of palette window.

 The Tinytiny    Window        Usage of tinytiny window.
Default State for Image Management      
Default State for Image Based Processing      
Default State for Document Based Processing      

__________________________________________
Related topics:



Dumping ground          Dumping ground for unused items.

__________________________________________
Related topics:



 
Navigation thru the program
                                        This is a topic that describes tips in using program.
After the program has been started, Users will be presented with the usual menu bar like 
most of the windows program, and an array of toolsbox buttons (if it's not hidden) to 
carrying out various command.

HELP WILL ALWAYS BE AVAILABLE BY PRESSING F1 KEY.

The menu bar is organized as group of logically related commands. 

System Menu      Minimize, maximize, close, restore, etc.
File Menu        Operations on file, printer, display, input, output, etc.
Edit Menu      Operations which may modify image or clipboard.
Option Menu      Miscellaneous setting related to preference, performance, display, as 

well as toolsbox, etc.
View Menu      Zoom in, zoom out, hide/show window.
Transform Menu      Geometric transform and image conversion.
Process Menu      Various image processing operation.
Window Menu      Window management commands.
Help Menu      Accessing program and supporting help.
Tools Menu      Alternative way to access toolsbox.

Additional image editing are accomplished thru Toolsbox , and are invoked by clicking at the 
appropriate icons as follow:

Toolsbox : Palette 

Toolsbox : Fonts    

Toolsbox : Text    

Toolsbox : Rectangle    

Toolsbox :    Pencil 

Toolsbox : Eraser    

Toolsbox : Drawing 

Toolsbox : Floodfill 

Toolsbox : Image Patching    

 
__________________________________________
Related topics:



File format
                                        This is a topic that describes various format.

__________________________________________
Related topics:



The Status Line
                                        The Status Line, as the name suggested, show the status or state of the 
program at the moment. It shows what the program is ready for what kind of operation. 
Except users choose it hide it, it will always be available, either the users are choose a 
command from the menu, or when the program is idled.
                                      Another use of the status line is to help users carrying out various sub-
commands from the toolsbox. When users click on a particular image editing tools on the 
toolsbox, an array of push button appear on the status, users can then click on these push 
button to perform various task.

__________________________________________
Related topics:

Toolsbox    Tools for adding text, drawing, and edit image.



The Palette Window 

The palette window, shown inside the <Reduced Image> window, show information about 
the palette of current active image and that of the clipboard (if an image has been pasted to
the clipboard).

The upper strip of the palette window shows palette of the clipboard (if an clipboard image 
exist and has been used by the application (pasted to the a window), otherwise it shows the 
default palette.

The lower strip of the palette window shows the palette of the current active image. It is 
displayed as a continuous spectrum of colors of the palette so that users can get a better 
feel of how the whole palette look like. However, for palette with many colors, some 
adjacent color entries may seemed to be blended together. In this case, a clearer picture for 
each color of the palette can be shown by clicking on the palette tools  icon, one the 
tools available thru the toolsbox icons.

__________________________________________
Related topics:

Palette Select Dialog
 Tools Box Palette 

    The Tinytiny    Window    



The Tinytiny Window 

 

This group of tiny windows consist of 16 small squares, and each square is a representation 
one reduced image of the <Reduced Image> window. Another sub-group of four squares 
represent four visible reduced images (if any). 

This sub-group of four squares is clearly indicated by a white square surrounding them. 
Clicking the left mouse button at the top, bottom, left, or right side of this sub-group move 
the change grouping of the reduced images which are visible.

__________________________________________
Related topics:

 The Palette Window      



Add Text to Image

Unit Setting Dialog Image Dialog
Rotate Image Dialog

__________________________________________
Related topics:



Warning of Capturing Image

This topic explains the Capturing image warning operation.
No operation except repaint screen from File-menu is allowed.

__________________________________________
Related topics:



 
Dumping ground

Capture Image to Window    
Capture Image to Window    
Merge Two Image Top-Bottom    
Merge Two Image Left-Right    
Select Top Merge Image    
Select Bottom Merge Image    
Select Left Merge Image    
Select Right Merge Image    
Default State for Image Editing    
Default State for Image Management    

Text Editing for the Image    
Resize and Move Text    

Old Stitch Image    
Stitch Image from another Window    
Stitch Image to (from) Clipboard Image    
Select Base Image to Stitch    
Select Image to Stitch on Base Image    
Select Image for Clipboard to Stitch    

Scale Image    
Deskew Image    
Scale Image    
Deskew Image    

data compression method 
current textline 
current drawing 
drag mouse 
selected rectangle    
commit text 
drawing foreground 
background color 
foreground color 
drag mouse    
Capture    to clipboard Capture    to window 
File open dialog File open dialog 
File print dialog Printer setup dialog 
Palette tools dialog Font setup dialog 
Merge two image dialog Resolution setting dialog 
Profile dialog Display options dialog 
Rotate image dialog Scale dialog 
Threshold dialog Filter dialog 
Customize filter dialog 
Equalization dialog Brighten dialog 
File save dialog 
F dialog F dialog 

Capture topic 
Stitch topic 



Mergetwo    topic 
Scale topic 
Deskew topic 
clipboard 
foreground color select 
background color select olor 
current palette 

Capture Image Basic 
Stitch Image Basic 
Merge Two Image Basic 
Deskew Image Basic 
Text Editing Basic 
Capture topic 

WinHelp 
Eureka! 
Clipboard
Where it is
Italic

Tools Box Palette 
The Palette Window 

Palette Setting Dialog
Save Configuration Dialog 
Cut Rectangle Cut selected rectangle from the image.
Copy Rectangle Copy selected rectangle to new window.
Create New Image Create a new image.
Palette Use    Palette usage.



Edit Cut Rectangle Command

This topic explains the Edit menu's Cut Rectangle command.

__________________________________________
Related topics:



Edit Copy Rectangle Command

This topic explains the Edit menu's Copy Rectangle command.

__________________________________________
Related topics:







 



Image Processing basic

                                        This program offer s a variety of image processing operation in addition 
to other basic editing tools and image transformation. 

__________________________________________
Related topics:



Operations on Images

Operations to be performed on images.
    
Capture Image Basic    General concept and description.
Merge Two Image Basic    General concept and description.
Text Editing Basic    General concept and description.
Stitch Image Basic    General concept and description.
Scale Image Basic    General concept and description.
Deskew Image Basic    General concept and description.

__________________________________________
Related topics:



Capturing Image Basic

Users can capture any portion of the screen and paste it to clipboard or another window.

If users specify the capture to window, a Capture    to window dialog will be shown. If users 
specify the capture to clipboard, a Capture    to clipboard dialog will be shown.

The displayed dialog acts as a guide to users and also act like a pause control button in a 
cassette recorder. The capturing operation is still on hold until users click on  or 

.button to proceed with the operation or abort the operation.

During this so called pause control period, users can rearrange the desktop to have the 
appearance they desire or show portion of the screen image they want to capture. 

If users click on the  button on the displayed dialog box, the cursor will be changed 
to cross-hair shape 

 to signal users to start the capturing operation. Portion of the screen (a rectangle) 
can be selected by anchoring or specifying the upper left corner by pushing down the left 
mouse button. Users then drag mouse until the desired rectangle is specified (color of 
portion of the screen selected will be inverted). Users signal the completion of the selection 
process by releasing the left mouse button.

After users complete the selection process, capturing operation will be carried out.

__________________________________________
Related topics:

Edit menu : Capture to Clipboard 
Edit menu : Capture to Window 



Stitch Image Basic

This topic explains the stitch image operation basic.

One of the useful feature of this program is that it allow users using images from a variety of
sources to stitch onto the base image. The image maybe from another window, clipboard, or
portion of image cut from the base image itself. Furthermore, the image used to stitch on the
base image can also be scaled to the desired size and put onto any location that users want.

There are basically three kind of stitch operations:

      Stitch from same image    Users access this command from rectangle toolsbox by clicking 
on the  button. After entering the rectangle toolsbox, users specify a selected 
rectangle and then click on the 

 button to enter mode of operation which allow user to move and resize the image 
under the selected rectangle . After getting the desired size and put on the location users 
want, click on the 

 button. The resulting image still has the same size as the base image.

      Between two image    Users process this operation by clicking on the Stitch command on 
the "Edit submenu". After the command has been executed, users will be instruct of how to 
select stitching and base image on the status line.

      To and from Clipboard    Users process this operation by clicking on the Stitch command 
on the "Edit submenu". After the command has been executed, users will be instruct of how 
to select stitching and base image on the status line.

Operations for stitching images between two image or between a base image and clipboard 
are very flexible. Once users entered this mode of operation, they can make a lot of 
adjustment such as changing which image to be base image or stitching image, restart the 
another operation under new circumstances, etc. Users can also temporarily halt the 
operation and do other operation, perhaps preparing another stitch operation and then come
back to do the stitch operation again.

__________________________________________
Related topics:

Toolsbox : Rectangle : Stitch(OK)            
 

Overview : Merge two image Basic 
Edit menu : Stitch Image from Window.
Edit menu : Stitch Image from Clipboard 
Stitch Image from another Window    
Stitch Image to (from) Clipboard Image    



Merge Two Image Basic

This command allow users to merge two image together in a seamless manner.

After execute the Merge Two Image command from the Edit Submenu, Users are presented 
with a dialog box to select how (which direction) the image are merged. Then, they are 
instructed to select each image on the status line.

After the image selection are completed, merging images will be shown on a new window. 
Users can adjust position of each image by drag mouse in the direction they want. Users can
then choose action they want on the menu.

This command and the resulting mode of operation are very flexible. Once users entered this
mode of operation, they can make a lot of adjustment such as changing images to be 
merged, preview the result, restart the another merge operation under new circumstances, 
etc. Users can also temporarily halt the operation and do other operation, perhaps preparing
another merge operation and then come back to do the merge operation again.

This operation differs from stitch image operation in that both images to be merged are 
treated equally. Both images can be trimmed to eliminate unwanted portion of the images.

__________________________________________
Related topics:

Stitch Image Basic 



Scale Image Basic

Scale image operation allow users to get a scaled copy of the original image. Users can scale
the whole image or portion of the image. All operations can be initiated from the Scale 
command in the Transform Submenu . However, if users choose to scale only portion of the 
image, i.e. for a selected rectangle only, the operation will be redirection to rectangle 
toolsbox as if users have clicked on the    Toolsbox : Rectangle  icon.

When users execute the Scale command from the Transform Submenu, they will be 
presented with a dialog box to select various options 

Users can also perform scale image operation thru rectangle toolsbox by clicking on the 
Toolsbox : Rectangle  icon, and push on the Scale 

 button after specifying a    selected rectangle and have entered the move / resize 
mode (push the 

 on the status line when it's not grayed).

If users decided to proceed with the scaling operation, either thru the menu or toolsbox, 
they specify the scaled version of the image by drag mouse on the active image.

__________________________________________
Related topics:

Toolsbox : Rectangle  
Toolsbox : Rectangle : Resize            

 
Toolsbox : Rectangle : Scale            

 
Scale Image Dialog
Transform menu : Scale 
Scale Image in Progress 



Deskew Image Basic

This topic explains the Deskew operation basic .

Upon choosing the deskew command from the Transform Submenu the cursor will be change

to  to indicate that deskew operation is in progress. Users drag mouse at any location on
the active image, and a rectangle with a diagonal line will be displayed. The diagonal line 
will be the horizontal axis of the transformed image if users decided to proceed with the 
operation.

After users get the desired deskew angle, i.e. have specified new horizontal axis, they can 
decide either to proceed or abort the operation by clicking on the  or 

.button on the status line, respectively.

__________________________________________
Related topics:

Deskew Image Basic 
Deskew command 
Deskew Image in Progress 



Text Editing Basic

The basic unit of operation for text editing is a text line. Users create a new text line by 
clicking the left mouse button at the chosen location on the image.

Typical text editing involves some of the follow operations.

1.    Entering the text editing mode by clicking on the text tools     icon. Various push 
button will appear on the status line to perform a variety of functions.
2.    Status line button are :  

 
 
 
 
 
 
 
-
 
 
-
. Not all button be displayed simultaneously.

3.    Select the desired font by clicking on the font tools     icon.
4.    Click on the chosen location on the image where text will be entered.
5.    Enter the desired text or delete the character entered using the <BACKSPACE> key.
6.    Push <RETURN> key to complete text entry.
7.    Move text to chosen location and resize text to desired size by clicking on the Move or 
resize text  button and    drag mouse on the image.
8.    Push <RETURN> key to complete the Move or resize text operation.
9.    Click on the Foreground  button to change the foreground color text color. Click 
the button while the <SHIFT> key is down change the color in the reverse direction.
10.    Click on the Background  button to change the background color. Click the 
button while the <SHIFT> key is down change the color in the reverse direction.
11.    Click on the Transparency  or Opaque 

 button depending on whether users want the background text color to be written to 
the image or not.
12.    If the text line has been resized, users can restore the text line to original size by 
clicking on the original text  button, or revert to adjusted size again by clicking on 
the adjusted text 

-button.
13.    If characters spacing in a text line is not what the users hope for, they can affect the 
characters spacing by clicking on the    Pack  button to reduce characters spacing or 
Unpack 

 button to increase characters spacing. This operation's effect is more substantial for
italic text.



14.    If the characters spacing is still not what the users want, they can create several text 
lines instead and user the move or resize text feature as described in item number 7.
15.    If several text lines have been entered, users can move between text lines by clicking 
on the -button. Click the button while the <SHIFT> key is down will move between 
text line in the reverse direction.
16.    To exit text editing mode, click on the    Cancel  button.
17.    All text lines entered, edited, moved, resized, etc. will still be available for further 
editing until users click on the    write text line  or write all text 

 button.
18.    Even after text lines have been written to the image, and therefore will not be available
for further editing, they are not saved. To save changes to a file, choose the Save or Save As 
item in the File Menu .

__________________________________________
Related topics:

Tools Box Text 



Capturing Image to window

This topic explains the Capturing image to window operation.

__________________________________________
Related topics:

Overview : Capture topic 



Capturing Image to Clipboard

This topic explains the Capturing image to clipboard operation.

__________________________________________
Related topics:

Overview : Capture topic 



Selecting Top Image to Merge

This topic explains the Select top image to merge operation.
__________________________________________
Related topics:

Mergetwo    topic 



Selecting Bottom Image to Merge

This topic explains the Select Bottom image to merge operation.

__________________________________________
Related topics:

Mergetwo    topic 



Selecting Left Image to Merge

This topic explains the Select Left image to merge operation.

__________________________________________
Related topics:

Mergetwo    topic 



Selecting Right    Image to Merge

This topic explains the Select Right image to merge operation.

__________________________________________
Related topics:

Mergetwo    topic 



Merge Two Image (Top-Bottom) in Progress

Merge Two Image (Top-Bottom) operations is in progress, click on related topics to get more 
detail information.

__________________________________________
Related topics:

Edit menu : Merge Two Image 
Overview : Mergetwo    topic 



Merge Two Image (Left-Right) in Progress

Merge Two Image (Left-Right) operations is in progress, click on related topics to get more 
detail information.

__________________________________________
Related topics:

Edit menu : Merge Two Image 
Overview : Mergetwo    topic 



Text Editing

This topic explains the Text Editing operation.

__________________________________________
Related topics:



Text Resize and Move

Text Move/Resize operation mode is in progress. ALL OTHER EDITING OPERATIONS ARE 
DISABLED.

This mode of operation allow users to    --resize current text line--    or --move current text 
line-- to other location on the image.

A hand-shaped cursor  means users can move the text line to other location. A 
resize-cursor    

 means users can    resize the text line.

Users end this mode of operation my pushing the [RETURN] key.

***** Use must press [RETURN] key to resume other operation. *****
__________________________________________
Related topics:

Toolsbox : Text 



Default State for Document Based Processing

In default state for document based processing, the program accept character input from 
keyboard and are formatted according to current settings. These settings can be changed by
using Paragraph and Page Format command from Option Menu . 

On the status line, the left most character indicates whether its in the insert mode or 
overwrite mode for text input. The status line also show the page number of the current 
working document.

Some special keybord input meaning are as follow:

[HOME] -- packed the character string of the paragraph.
[END]      -- unpacked the character string of the paragraph.
[INS]        -- toggle between "insert" and "Overwrite" mode.
[ARROW] -- move cursor left, right, up, down.
[Cntl]+[left ARROW]      -- move cursor to the previous word.
[Cntl]+[right ARROW] -- move cursor to the next word.

To add something other than paragraph text to the document, such as drawings or 
customized text line to to the document, click on one of the icons on the left of the HUBBLE 
document window.

Add Image To Document    from Edit Menu    to add bitmap images to the document. If there 
is no active window opened, switch to    Image Based Processing from Option Menu to open 
or create images and then switch back to Document Based Processing .

These added images can be customized by using Move/Resize/Delete/Name Image Added 
command also from    Option Menu .

__________________________________________
Related topics:

Menu commands[Document Based] 



Default State for Image Editing

This topic explains the default state for image editing operations. Users can select operatio 
to perform by choosing commands from menu or click on toolsbox icons.

__________________________________________
Related topics:

Menu commands [Image Based] 
Toolsbox 



Default State for Image Management

This topic explains the default state for image management operation. On this state, The 
<Reduced Image> Window    has input focus. This window consist of    The Tinytiny    Window  
and The Palette Window windows.

Users can also choose this state by click on The <Reduced Image> Window        to set some 
global variables.

__________________________________________
Related topics:

 The Tinytiny    Window    
 The Palette Window      



Stitch Image

This topic explains the stitch image operation.

__________________________________________
Related topics:



Stitch Image from another Window in Progress

Stitch image from another window operation is in progress, click on related topics to get 
more detail information.

__________________________________________
Related topics:

Stitch Image Basic 
Edit menu : Stitch Image from Window.
Edit menu : Stitch Image from Clipboard 



Stitch Image from Clipboard in Progress

Stitch image from clipboard    operation is in progress, click on related topics to get more 
detail information.

__________________________________________
Related topics:

Stitch Image Basic 
Edit menu : Stitch Image from Window.
Edit menu : Stitch Image from Clipboard 



Select Base Image to Stitch

This topic explains the selection of base image to stitch operation.

__________________________________________
Related topics:



Select Image to Stitch on Base Image

This topic explains the selection of image to stitch on base image stitch operation.

__________________________________________
Related topics:



Select Image for Clipboard to Stitch

This topic explains the selection of image to stitch to (from) clipboard operation.

__________________________________________
Related topics:



Scale Image in progress

Scale image operation is in progress, click on related topics to get more detail information.

__________________________________________
Related topics:

Overview : Scale Image Basic 
Transform menu : Scale 
Scale Image Dialog



Deskew Image in progress

Deskew image operation is in progress, click on related topics to get more detail information.

__________________________________________
Related topics:

Overview : Deskew Image Basic 
Transform menu : Deskew 



Operations on Document

Operations to be performed on document.
 
Encircle Word(s) to Highlight    
Select Image to Add    
Locate Where to Add Image    
Move/Resize Image Added    
Add Image Description    
Shift Current Paragraph Basic    
Shift Current Document Page    
Rearrange Drawings, Images Added    
Document Detail View    
Document Print Preview    

__________________________________________
Related topics:



Shift Current Document Page

__________________________________________
Related topics:



Document Print Preview

__________________________________________
Related topics:



Rearrange Drawings, Images Added 

__________________________________________
Related topics:



Document Detail View

__________________________________________
Related topics:



Encircle Word(s) to Highlight

__________________________________________
Related topics:



Move/Resize Image Added

__________________________________________
Related topics:



Select Image to Add

__________________________________________
Related topics:



Add Image Description

__________________________________________
Related topics:



Shift Current Paragraph Basic

__________________________________________
Related topics:



Locate Where to Add Image

__________________________________________
Related topics:









 



        
Write all    (Toolsbox : Text Input)

This command will commit all text line to the image, i.e., all previously inputted text line will 
become part of the image and are no longer available for editing or for any kind of 
modification.

__________________________________________
Related topics:



                
Exit (Toolsbox : Text Input)

This command will let the users leave the text editing mode and return to default state of 
operation.

__________________________________________
Related topics:



         
Write line (Toolsbox : Text Input)

This command will commit current textline    to the image, i.e., it become part of the image 
and is no longer available for editing or for any kind of modification.

__________________________________________
Related topics:



         

Transparency / Opaque (Toolsbox : Text Input)

This command allow users to control some aspects of how the text line(s) to be written to 
the image is done. 

If users click on , opaque mode of writing text to image is selected. In this mode, 
background    text color is also written to the image as well as inputted text using foreground
color.

If users click on , transparent    mode of writing text to image is selected. In this 
mode, no background    text color is written to the image. Only    inputted text is written to 
the image using foreground text color.

__________________________________________
Related topics:



         
Foreground color (Toolsbox : Text Input)

This command will cycle thru the palette of the current image and select the foreground 
color. When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.
__________________________________________
Related topics:



         
Background color (Toolsbox : Text Input)

This command will cycle thru the palette of the current image and select the background 
color. When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.

__________________________________________
Related topics:



  

Move or resize (Toolsbox : Text Input)

This command will put the program in a mode for current active image that allow users to 
resize current text line or move current text line to other location on the image.

A hand-shaped cursor  means users can move the text line to other location. A 
resize-cursor    

 means users can    resize the text line.

Users end this mode of operation my pushing the <RETURN> key.

__________________________________________
Related topics:

Toolsbox : Text 



         
Adjusted / Original text (Toolsbox : Text Input)

This command will switch current textline to be displayed in the original or adjusted size (if 
the text line has been resized)

__________________________________________
Related topics:



         
Tab (Toolsbox : Text Input)

This command will cycle thru all text lines and select it as current textline. When clicking
 while the <SHIFT> key is being pressed will cycle thru the text lines in the reverse 

direction.

__________________________________________
Related topics:



         
Pack / Unpack (Toolsbox : Text Input)

This command will switch current textline to be displayed as PACK or UNPACK.

UNPACK means every character will occupy a specific width.
PACK means adjacent characters will be displayed closer than those of UNPACK if possible. 
This is significant especially for italic characters.

__________________________________________
Related topics:



         
Stitch (Toolsbox : rectangle)

This command is available after user push the  button, which allow users perform 
operation USING the selected area.

The function of this command is to stitch the re-located and/or re-sized version of the 
selected area to the base image. 

This command is grayed and is unavailable after user push the  button, which allow 
users perform operations only ON the selected area on the image.

__________________________________________
Related topics:



         
Cancel (Toolsbox : rectangle)

This command will let the users leave the toolsbox and return to default state of operation.

__________________________________________
Related topics:



         
Copy Selected Area (Toolsbox : rectangle)

This command will perform the operation which copy    selected area of the image to a new 
window.

__________________________________________
Related topics:



         
Cut Selected Area (Toolsbox : rectangle)

This command will perform the operation which cut the selected area from current active 
image and fill the area with current background color.

__________________________________________
Related topics:



         
Select Area (Toolsbox : rectangle)

This command will put user in mode of operations which users can perform ON the selected 
area. These operations include cutting the area from the image (click on ), and copy 
the area onto a new window (click on 

). 

Users can specify selected area by drag mouse on the active image. Or, after the initial area 
selection, move the location of selected area when a hand-shaped cursor  appears, 
or adjust the size of the selected area while the resize-cursor    

 appears.

A double click on the left mouse button will reset the selected area.

__________________________________________
Related topics:



         
Move / Resize (Toolsbox : rectangle)

This command will put user in mode of operations which users can perform operations 
USING the selected area. Operations under this mode include scaling (click on  
button), and stitch the selected area    (which may have been    resized) to any location of the
image (click on 

 button).

Users can move the selected area when a hand-shaped cursor  appears, or resize the
selected area while the resize-cursor    

 appears.

__________________________________________
Related topics:



         
Scale Selected Area (Toolsbox : rectangle)

This command is available after user push the  button, which allow users perform 
operation USING the selected area.

The function of this command is to scale the selected area and copy the result to a new 
window. 

This command is grayed and is unavailable after user push the  button, which allow 
users perform operations only ON the selected area on the image.

__________________________________________
Related topics:



         
Setup (Toolsbox : rectangle)

This command invoke a dialog box which control how to resize selected area of the image.

__________________________________________
Related topics:



        
Write all    (Toolsbox Drawing)

This command will commit all drawings to the image, i.e., all previously drawn drawings will 
become part of the image and are no longer available for editing(move or resize), or for any 
kind of modification (change line attribute or color).

__________________________________________
Related topics:



                
Exit (Toolsbox Drawing)

This command will let the users leave the drawing mode of the toolsbox and return to 
default state of operation.

__________________________________________
Related topics:



         
Write line (Toolsbox Drawing)

This command will commit current drawing to the image, i.e., its will become part of the 
image and is no longer available for editing(move or resize), or for any kind of modification 
(change line attribute or color).

__________________________________________
Related topics:



         

Transparency / Opaque (Toolsbox Drawing)

This command allow users to control the color whether to paint with background color for 
the area bounded by the rectangle enclosing the drawing, excluding the current drawing 
itself.

If users click on , opaque mode of writing the drawing to image is selected. In this 
mode, background    color is also written to the image as well as the current drawing using 
foreground color.

If users click on , transparent    mode of drawing to image is selected. In this mode, 
no background    color is written to the image. Only the current drawing is written to the 
image using foreground color.

__________________________________________
Related topics:



         
Foreground color (Toolsbox Drawing)

This command will cycle thru the palette of the current image and select the foreground 
color. When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.
__________________________________________
Related topics:



         
Background color (Toolsbox Drawing)

This command will cycle thru the palette of the current image and select the background 
color. When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.

__________________________________________
Related topics:



  

Move or resize (Toolsbox Drawing)

This command will put the program in a mode for current active image that allow users to 
resize and / or move current drawing on the image.

A hand-shaped cursor  means users can move the current drawing to other location. 
A resize-cursor    

 means users can    resize the current drawing .

Users end this mode of operation my pushing the <RETURN> key. or click on this same 
button which is now displayed as the  button.

__________________________________________
Related topics:



         
Tab (Toolsbox Drawing)

This command will allow users to cycle thru all drawings and, as the selection passed thru 
each drawing, select it as current drawing. When clicking  while the <SHIFT> key is 
being pressed, the process will take place in reverse direction.

__________________________________________
Related topics:



         
Solid draw (Toolsbox Drawing)

This command wil fill area bounded by current drawing with the drawing's border color.

To revert to the original drawing, click on this same button, which is now the     
button.

__________________________________________
Related topics:

     Draw Toolsbox: Frame draw 

     Draw Toolsbox : Fill area 

  
    Draw toolsbox : Transparency 

  
    Text toolsbox : Transparency 



         
Draw line (Toolsbox Drawing)

This command will put the program in a mode to draw a line with current    line style and 
foreground color 
__________________________________________
Related topics:

Brush Selection .
Line Style Selection .



         
Draw Rectangle (Toolsbox Drawing)

This command will put the program in a mode to draw a rectangle with current    line style 
and foreground color 
__________________________________________
Related topics:

Brush Selection .
Line Style Selection .



         
Draw circle (Toolsbox Drawing)

This command will put the program in a mode to draw a circle with current    line style and 
foreground color 

__________________________________________
Related topics:

Brush Selection .
Line Style Selection .



         
Draw rounded rectangle (Toolsbox Drawing)

This command will put the program in a mode to draw a rounded rectangle with current    
line style and    foreground color 

__________________________________________
Related topics:

Brush Selection .
Line Style Selection .



         
Edit drawing (Toolsbox Drawing)

This command will put the program in a mode for current active image that allow users to 
draw a new drawing. Users can then select the drawing type by clicking on the  , 

 , or    
 button.

__________________________________________
Related topics:



         
Frame only (Toolsbox Drawing)

This command make the drawing being done with current drawing 's    line style, and    
foreground color. Area inside the drawing are not filled except for    opaque mode of drawing.

__________________________________________
Related topics:

     Draw Toolsbox : Solid draw 

     Draw Toolsbox : Fill area 

  
    Draw toolsbox : Transparency 

  
    Text toolsbox : Transparency 



         
Fill area (Toolsbox Drawing)

This command wil fill area bounded by current drawing with current foreground color.

To revert to the original drawing, click on the  button.

__________________________________________
Related topics:

     Draw Toolsbox : Solid draw 

     Draw Toolsbox: Frame draw 

  
    Draw toolsbox : Transparency 

  
    Text toolsbox : Transparency 



        
Write all    (Toolsbox : Area Fill)

This command will commit all area fill to the image, i.e., they will become part of the image 
and are no longer available for editing or for any kind of modification.

__________________________________________
Related topics:



                
Exit (Toolsbox : Area Fill)

This command will let the users leave the area fill mode and return to default state of 
operation.

__________________________________________
Related topics:



         
Write Area (Toolsbox : Area Fill)

This command will commit current selected fill area to the image, i.e., it become part of the 
image and is no longer available for editing or for any kind of modification.

__________________________________________
Related topics:



         

Transparency / Opaque (Toolsbox : Area Fill)

This command allow users to view and identify the current active fill area .
__________________________________________
Related topics:



         
Foreground color (Toolsbox : Area Fill)

This command will cycle thru the palette of the current image and select the foreground 
color as the fill color for the filled area. Clicking at the  button while the <SHIFT> key
is being pressed will cycle thru the palette in reverse direction. Clicking at the 

 button while the <Cntl> key is being pressed will cycle thru the palette faster.
__________________________________________
Related topics:



         
Tab (Toolsbox : Area Fill)

This command will cycle thru all area fill performed and select it as current active fill area. 
When clicking  while the <SHIFT> key is being pressed will cycle thru the filled 
area(s) in the reverse direction.

__________________________________________
Related topics:



        
Write all    (Toolsbox : Image Patching)

This command will commit all changes to the image, i.e., all previously performed operations
will become part of the image and are no longer available for editing(move or resize).
__________________________________________
Related topics:



                
Cancel (Toolsbox : Image Patching)

This command will let the users leave the irregular area selection mode of the toolsbox and 
return to default state of operation.

__________________________________________
Related topics:



         
Write (Toolsbox : Image Patching)

This command will commit changes to the image using selected area permanant, i.e., its will
become part of the image and is no longer available for editing(move or resize).

__________________________________________
Related topics:



         

Transparency / Opaque (Toolsbox : Image Patching)

Not yet implemented.
__________________________________________
Related topics:



         
Foreground color (Toolsbox : Image Patching)

This command will cycle thru the palette of the current image and select the foreground 
color. When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.
__________________________________________
Related topics:



         
Background color (Toolsbox : Image Patching)

This command will cycle thru the palette of the current image and select the background 
color. When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.

__________________________________________
Related topics:



  

Move or resize (Toolsbox : Image Patching)

This command will put the program in a mode for current active image that allow users to 
resize and / or move selected area (except for freehand drawing) image.

A hand-shaped cursor  means users can move the selected area to other location. A 
resize-cursor    

 means users can    resize the selected area.

Users end this mode of operation my pushing the <RETURN> key.

__________________________________________
Related topics:



         
Tab (Toolsbox : Iimage Patching)

This command will allow users to cycle thru all selected area and, as the selection passed 
thru each selected area, select it as current selected area. When clicking  while the 
<SHIFT> key is being pressed, the process will take place in reverse direction.

__________________________________________
Related topics:



         
 

Adjust Area (Toolsbox : Image Patching)

This command wil fill area bounded by current drawing with the drawing's border color.

To revert to the original drawing, click on this same button, which is now the     
button.

__________________________________________
Related topics:



         
Draw Rectangle (Toolsbox : Image Patching)

Define a rectangular selected area on the image.
__________________________________________
Related topics:



         
Draw circle (Toolsbox : Iimage Patching)

Define a circular selected area on the image.

__________________________________________
Related topics:



         
Draw rounded rectangle (Toolsbox : Image Patching)

Define a rounded rectangular selected area on the image.

__________________________________________
Related topics:



         
Put area (Toolsbox : Image Patching)

This command will put the program in a mode that allow users to move protion of the image 
under the selected area to any place on the image.

After clicking on the  button on the status line, users the move the mouse cursor 
over the selected area (a hand-shaped cursor 

 should appear), users may then drag mouse to put protion of the image under the 
previously selected area to any location the users want.

If resizing is not disabled, users may be able to resize as well as move the selected area .
(A resize-cursor  will appears)
__________________________________________
Related topics:

 Toolsbox : Image Patching  Move or resize area selection 



         
Free hand drawing (Toolsbox : Image Patching)

This command make the drawing being done with current drawing 's    line style, and    
foreground color. Area inside the drawing are not filled except for    opaque mode of drawing.

__________________________________________
Related topics:



        
Write all    (Toolsbox : Pencil (pixel editing) Tool)

This command will commit all logical pixel groups to the image, i.e., all change will become 
part of the image and are no longer available for editing or for any kind of modification.

__________________________________________
Related topics:



                
Exit (Toolsbox : Pencil (pixel editing) Tool)

This command will let the users leave pixel editing mode and return to default state of 
operation.

__________________________________________
Related topics:



         
Write group (Toolsbox : Pencil (pixel editing) Tool)

This command will commit the current pixel group to the image, i.e., it will become part of 
the image and is no longer available for editing or for any kind of modification.

__________________________________________
Related topics:



         

Transparency / Opaque (Toolsbox : Pencil (pixel editing) Tool)

This command allow users to control some aspects of how the pixel is written to the image. 

If users click on , the opaque mode is selected. In this mode, background    color is 
also written to the image as well as edited pixels using foreground color.

If users click on , transparent    mode is selected. In this mode, no background    color 
is written to the image. Only edited pixels are written to the image using foreground color.

note1:  and 
 are the same button.

note2: Currently, this feature may be disabled.

__________________________________________
Related topics:



         
Foreground color (Toolsbox : Pencil (pixel editing) Tool)

This command will cycle thru the palette of the current image and select the foreground 
color . When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.
__________________________________________
Related topics:



         
Background color (Toolsbox : Pencil (pixel editing) Tool)

This command will cycle thru the palette of the current image and select the background 
color . When clicking  while the <SHIFT> key is being pressed will cycle thru the 
palette in reverse direction.

 button is enabled only for opaque mode of pixel editing.

note: Currently, this feature may be disabled.

__________________________________________
Related topics:



  

Move or resize (Toolsbox : Pencil (pixel editing) Tool)

This command will put the program in a mode for current active image that allow users to 
resize or move current pixel group to other location on the image.

A hand-shaped cursor  means users can move the    current pixel group to other 
location. A resize-cursor    

 means users can    resize the    current pixel group .

Users end this mode of operation my pushing the <RETURN> key.

note1: Currently, resize operation may be disabled in current version.

__________________________________________
Related topics:



         

Adjusted / Original pencil (Toolsbox : Pencil (pixel editing) Tool)

This command will switch between displaying original or adjusted size of current pixel group 
(if the current pixel group has been resized)

note: Currently, this feature may be disabled.

__________________________________________
Related topics:



         
Tab (Toolsbox : Pencil (pixel editing) Tool)

This command will cycle thru all logical pixel group and select it as the current pixel group. 
When clicking the  button while the <SHIFT> key is being pressed will cycle thru the 
logical pixel group in the reverse direction.

__________________________________________
Related topics:



         
Erase (Toolsbox : Pencil (pixel editing) Tool)

This command will put the program in a mode which users may drag mouse to overlay and 
erase pixel(s) in the    current pixel group 

__________________________________________
Related topics:









 



Dialog Procedure

This topic explains how to use various dialog procedure

Create New Image Dialog
File Open Dialog
File Save Dialog
Open Option Dialog
Print Options Dialog
Printer Setup Dialog
TIFF Sub-Image Select Dialog

Brush Shape and Size Dialog
Line Style Select Dialog
Pattern Select Dialog 
Palette Setting Dialog
Palette Select Dialog
 
Resolution Setting Dialog
Custom Palette Dialog
Profile Setting Dialog
Fonts Setup Dialog 
Palette Usage Dialog 
Display Option Dialog 
Image Info Dialog 
System    Info Dialog 
Save Configuration Dialog 

Tone and Color Balance Dialog
Interactive Equalization Dialog
Custom Contrast Dialog
Custom Image Filtering Dialog
Rotate Image Dialog
Scale Image Dialog
Thresholding Dialog
Merge Two Image Dialog
Custom Dithering Dialog
Add New Dithering Matrix Dialog
Build Dithering Palette Dialog
Document Page and Paragraph Format Dialog

__________________________________________
Related topics:



Create New Image Dialog

Create New Image Dialog Box is invoked when user choose File menu :New command from 
File Menu .

Command or Entry Function 

Image type Users select from a list of the target image type.
Dimension A group box which enclose a group of radio buttons 

that allow users to define target image image 
dimension.

Unit A group box which enclose a group of radio buttons 
that allow users to choose unit of measurement that 
users prefer.

Resolution An entry which users can enter the target image's 
resolution for the chosen unit of measurement.

OK To accept all values entered and create target image 
specified, click on OK button or push the [RETURN] 
key.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

File : New 
File : Open 



Profile Setting Dialog

Profile Setting Dialog Box is invoked when users choose the Profile command from the 
Option Menu .

Command or Entry Function 

Unit A group box which enclose a group of radio buttons 
that allow users to choose unit of measurement to 
DISPLAY the image that users prefer.

Dithering Method A group box which enclose a group of radio buttons 
that allow users to choose default dithering technique 
in case video display adapter cannot support as much 
color as the input image.

Misc. setting A group box which enclose a group of check boxes 
which users can set various options.

OK To accept all values entered as default values.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Option : Profile    



Tone and Color Balance Dialog

Tone and Color Balance Dialog Box is invoked when users choose the Tone and Color Balance
command from the Process Menu .

Command or Entry Function                                                                                       

Color components Used can selectively choose which color component to
adjust.

Brightening Method A group box which enclose a group of radio buttons 
that allow users to select how to adjust intensity level 
of the image.

R, G, B Scrollbar Used to adjust intensity level of the red, green, and 
blue components, respectively, for LINEAR brightening
method.

Modify color table A check box to select either to keep the color table of 
the indexed color or indexed gray scale image intact 
or modify the color table to achieve the desired 
intensity level.

Histogram Scaling factor used to graphically display the 
distribution of the intensity level.

Edit box Users can enter how much to adjust intensity level for 
LINEAR brightening method.

Old Histogram Used to graphically display intensity distribution the 
original image.

New Histogram Used to graphically display intensity distribution the 
target image.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Process: Tone and Color Balance    



Interavive Equalization Dialog

interactive Equalization Dialog Box is invoked when users choose the Interactive 
Equalization command from the Process Menu .

Command or Entry Function                                                                                       

Color components Used can selectively choose which color component to
adjust.

Equalize Method A group box which enclose a group of radio buttons 
that allow users to select how to adjust contrast level 
of the image.

Intensity value A group box which enclose an edit box and a scrollbar 
to indicate intensity adjustment to the image before 
applying equalization technique chosen on the image.

Modify color table A check box to select either to keep the color table of 
the indexed color or indexed gray scale image intact 
or modify the color table to achieve the desired 
intensity level.

Histogram Scaling factor used to graphically display the 
distribution of the intensity level.

Vertical scrollbar Used to set threshold level for LINEAR equalization 
method.

Threshold threshold value for LINEAR equalization method.
Old Histogram Used to graphically display intensity distribution the 

original image.
New Histogram Used to graphically display intensity distribution the 

target image.
OK To accept all values entered as default values, click on

OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Process: Interactive Equalization    



Custom Image Filtering Dialog

Custom Image Filtering Dialog Box is invoked when users choose the Custom Image Filtering 
command from the Process Menu .

Command or Entry Function                                                                                       

Filter Operation A listbox that include various kind of image processing
operations.

Filter Type A listbox that include assortment of filters for 
particular kind of filter operation chosen.

Filter Kernel A listbox that show kernel value of a particular filter 
chosen.

Custom Filter User-defined custom filter.
Delete Group Define a group of user defined filter.
Delete Filter Delete a user-defined filter.
Save Filter List Save user-defined filter for future use.
Scaling Method A group box which enclose a group of radio buttons 

that allow users to select how to adjust (scale) the 
resulting operation using a particular filter kernel.

Scale An edit box that users can enter value to indicate how
much to adjust (scale) using particular filter kernel.

Kernel Name An edit box that users can enter to give the mnemonic
name for user defined kernel specified.

Add Filter to Group An edit box that users can enter to specify which filter 
type the user defined kernel belong to. 

Equalize Method A group box which enclose a group of radio buttons 
that allow users to select how to adjust contrast level 
of the image.

Add Filter A push button which indicate users accept user 
defined kernel specified.

User Defined Filter A group box which enclose a group of edit box used to
specify new filter kernel designed.

Dimension A group box which enclose a group of radio button 
used to specify dimension of matrix specifying the 
new user defined filter kernel.

Type A group box which enclose a group of radio button 
used to specify the new user defined filter kernel 
contain integer or real value.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.



__________________________________________
Related topics:

Process: Custom Image Filtering    



Image Info Dialog

Image Info Dialog Box is invoked when users choose the Image Info command from the View 
Menu .

Command or Entry Function                                                                                       

OK Click on OK to close the dialog box.
Verbose Info. Click on this button to display more detailed 

information.
Concise Info. Click on this button to display concise version of the 

message.

__________________________________________
Related topics:

View : Image Info    



System Info Dialog

System Info Dialog Box is invoked when users choose the System Info command from the 
View Menu .

Command or Entry Function                                                                                       

OK Click on OK to close the dialog box.
Verbose Info. Click on this button to display more detailed 

information.
Concise Info. Click on this button to display concise version of the 

message.

__________________________________________
Related topics:

View : System Info    



File Open Dialog

Open File Dialog Box is invoked when users choose the Open command from the File Menu .

Command or Entry Function                                                                                       

Filename Type filename to open or select files from "Files" 
listbox.

Directory Display the current path (drive and directory).
Files This listbox display all files on current path with 

specified file extension (file format).
File Format A file format listbox list on all formats supported. Click 

on an item in the listbox to specify file format desired.
Drive / Directory A listbox which lists all drives and sub-directory of 

current path.
OK To accept all values entered as default values, click on

OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

File : New    
File : Open    



File Save Dialog

File Save Dialog Box is invoked when users choose the Save command from the File Menu .

Command or Entry Function                                                                                       

Filename Type filename to open or select files from "Files" 
listbox.

Directory Display the current path (drive and directory).
Files This listbox display all files on current path with 

specified file extension (file format).
File Format A file format listbox list on all formats supported. Click 

on an item in the listbox to specify file format desired.
Data compression A file format listbox list on all data compression 

methods supported for the selected file format. Click 
on an item in the listbox to specify data compression 
method desired.

Drive / Directory A listbox which lists all drives and sub-directory of 
current path.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

File : Save    
File : Save As    



Brush Shape and Size Dialog

Brush Shape and Size    Dialog Box is invoked when users choose the Brush Selection 
command from the Option Menu .

Command or Entry Function                                                                                       

Shape A group box which enclose a list of brush shape to 
choose from.

Hatch A group box which enclose a list of hatching pattern to
choose from.

Style A group box which enclose a list of style of the brush, 
users can choose either SOLID or HATCH brush style.

Width An edit box which users can enter the width of the 
brush of the selected shape and style.

Height An edit box which users can enter the height of the 
brush of the selected shape and style.

Current drawing only A check box which users can check or uncheck to 
indicate whether the brush style chosen is global or to
be applied to current editing image only.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Option : Brush Selection    



Line Style Select Dialog

Line Style Select    Dialog Box is invoked when users choose the Line Selection command 
from the Option Menu .

Command or Entry Function                                                                                       

Style A group box which enclose a list of style of the line, 
users can choose either SOLID or various combination 
of DOT and DASH line style.

line width (thickness) An edit box which users can enter the width of the 
solid line if the solid line style is chosen.

Current drawing only A check box which users can check or uncheck to 
indicate whether the brush style chosen is global or to
be applied to current editing image only.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Option : Line Selection    



Pattern Select Dialog

Pattern Select    Dialog Box is invoked when users choose the Pattern Selection command 
from the Option Menu .

__________________________________________
Related topics:

Option : Pattern Selection    



Custom Palette Dialog

This topic explains how to use Custom Palette Dialog Box.

Command or Entry Function                                                                                       

__________________________________________
Related topics:

The Palette Window 



Rotate Image Dialog

Rotate Image Dialog Box is invoked when users choose the Rotate Image command from the
Transform Menu .

Users can specify which direction and by how much the image will be rotated.

Command or Entry Function                                                                                       

Scrollbar used to specify rotating angle.
Reset Restart rotate angle specification.
OK To accept all values entered as default values, click on

OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Transform : Rotate Right    
Transform : Rotate Left    
Transform : Rotate Image    
Transform : Deskew    



Scale Image Dialog

Scale Image Dialog Box is invoked when users choose the Scale command from the 
Transform Menu .

Command or Entry Function                                                                                       

Direction A group box consisted of choices (in the form of radio 
buttons) that let users specify if the operation is to 
scale the image in horizontal, vertical, or both 
direction. Is the target image is to maintain the aspect
ratio.

Region A group box consisted of choices (in the form of radio 
buttons) that let users specify either to scale the 
whole image or just the rectangular selected area 
of the image.

OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Scale Image Basic 
Transform menu : Scale 
Scale Image 



Thresholding Dialog

Thresholding Dialog Box is invoked when users choose the Threshold            Convert image 
according to intensity threshold command from the Transform Menu .

Command or Entry Function                                                                                       

At / Below Threshold A group box which enclose options about action taken 
for intensity at and below the threshold value.

Above Threshold A group box which enclose options about action taken 
for intensity above the threshold value.

Threshold An edit box and a scrollbar to specify the threshold 
intensity.

Modify color table A check box to select either to keep the color table of 
the indexed color or indexed gray scale image intact 
or modify the color table to achieve the desired 
intensity level.

Histogram Scaling factor used to graphically display the 
distribution of the intensity level.

Old Histogram Used to graphically display intensity distribution the 
original image.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Process: Threshold    



Merge Two Images Dialog

Merge Two Images Dialog Box is invoked when users choose the 
Merge Two Image command from the Edit Menu .

Command or Entry Function                                                                                       

Merge Direction A group box consisted of choices (in the form of radio 
buttons) that let users specify if the operation is to 
two image left-right or top-bottom.

OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Edit : Merge Two Image    
Edit : Stitch Image from Window    
Edit : Stitch Image from Clipboard    



Print Options Dialog

Print Options Dialog Box is invoked when users choose the Print 
command from the File Menu .

Command or Entry Function                                                                                       

Size A group box consisted of choices (in the form of radio 
buttons) that let users specify the size of the printed 
copy of the image.

Margin A group box consisted of choices (in the form of radio 
buttons) that let users specify margins of the page to 
be printed. 

Unit Click on the arrow of the combo box to choose 
preferred unit of measurement.

Selected region only Click on this check box to indicate whether to print the
whole image or just a portion of the image if a 
rectangular selected area has been defined.

OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

File : Print    
File : Print Setup    



Printer Setup Dialog

Printer Setup Dialog Box is invoked when users choose the Print Setup command from the 
File Menu .

Command or Entry Function                                                                                       

Printer List A listbox showing all printer installed. Users can select
a printer from the list as active current printer.

Measurement Unit A group box consisted of choices (in the form of radio 
buttons) that let users specify the preferred unit of 
measurement.

Setup Click on this button to invoke installed printer setup 
program.

OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

File : Print    
File : Print Setup    



TIFF Sub-Image Selection Dialog

This topic explains how to use TIFF Sub-Image Selection Dialog.

This dialog box is invoked if there are more than one image in the TIFF file when users 
execute the Open command from the File Menu .

Command or Entry Function                                                                                       

Image Info A group box which enclose lines of text describing the 
characteristic of the sub-image.

Type of sub-file A group box consisted of check boxes to indicate 
attribute(s) of the sub-image.

Previous Click on this button to view previous sub-image.
Next Click on this button to view next sub-image.
Scrollbar Click on this scrollbar to scroll through sub-images of 

the TIFF file.
OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

File : Open    



Palette Setting Dialog

This topic explains how to use Palette Setting Dialog Box.

Command or Entry Function                                                                                       

__________________________________________
Related topics:

The Palette Window 



Unit of Measurement Setting Dialog

This topic explains how to use Unit of Measurement Setting dialog Box.

Command or Entry Function                                                                                       

__________________________________________
Related topics:



Resolution Setting Dialog

Resolution Setting Dialog Box is invoked when users choose Resolution command from the 
Edit Menu .

Command or Entry Function                                                                                       

Horizontal Resolution An edit box which users can enter to specify new 
horizontal resolution of the image.

Vertical Resolution An edit box which users can enter to specify new 
vertical resolution of the image.

Unit A group box consisted of choices (in the form of radio 
buttons) that let users specify preferred unit of 
measurement.

OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Edit : Resolution    



Fonts Setup Dialog

This topic explains how to use Fonts Setup Dialog Box.

Command or Entry Function                                                                                       

Point Click on the arrow of this combo box to choose point 
size of the text.

Fonts A listbox showing the list of fonts available.
Style A group box consisted of choices (in the form of check

box) that let users specify font style. Users can choose
desired style by checking the appropriate boxes.

OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:



Open Option Dialog

This topic explains how to use Open Option Dialog Box.

Command or Entry Function                                                                                       

__________________________________________
Related topics:

File : Open    



Palette Select Dialog

This topic explains how to use Palette Select Dialog Box.

This dialog box is invoked from the Palette tools , which is one of the tools available 
thru toolsbox icons.

After users click on the  icon, this dialog is displayed. It presents users with colors of 
the current image's palette along with current image's foreground and background colors.

Users click on the foreground color select or    background color select rectangle on the 
dialog box to indicate which one they want to set, and then click on one the color in the 
current palette, box to make the color selection.

Command or Entry Function                                                                                       

Current Palette A group box consisted of choices (in the form of small 
boxes) that let users can click to specify color for 
foreground or background.

Select Color A group box consisted of choices (in the form of two 
boxes) that let users can click to specify whether the 
color change is for foreground or background color.

For current text or drawing only A check box that let users specify whether the 
selected palette is global or to be applied to current 
editing image only.

OK To accept all values entered selection, click on OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Tools Box Palette 
The Palette Window 



Palette Usage Dialog

This topic explains how to use Palette Usage Dialog Box.

Command or Entry Function                                                                                       

__________________________________________
Related topics:

Tools Box Palette 
The Palette Window 



Display Option Dialog

Display Option Dialog Box is invoked when users choose the Display Option command from 
the Option Menu .

Refer to TUTORIAL.TXT and NEWINFO.TXT for updated information on option available.

Command or Entry Function                                                                                       

_________________________________________
Related topics:

Tools Box Palette 
The Palette Window 

Option : Display Option    



Rotate Image Dialog

Rotate Image Dialog Box is invoked when users choose the Rotate Image command from the
Transform Menu .

Command or Entry Function                                                                                       

__________________________________________
Related topics:

Transform : Rotate Right    
Transform : Rotate Left    
Transform : Rotate Image    
Transform : Deskew    



Save Configuration Dialog

This topic explains how to use Save Configuration Dialog Box.

Command or Entry Function                                                                                       

__________________________________________
Related topics:



Image Deskew Dialog

Image Deskew Dialog Box is invoked when users choose the Deskew 
command from the Transform Menu .

Command or Entry Function                                                                                       

__________________________________________
Related topics:

Deskew topic 

Transform : Rotate Right    
Transform : Rotate Left    
Transform : Rotate Image    
Transform : Deskew    



Build Dithering Palette Dialog

Build Dithering Palette Dialog Box is invoked when users choose the Custom Conversion and 
Dithering command from the Transform Menu .

Command or Entry Function                                                                                       

red levels number of intensity for red components.
green levels number of intensity for green components.
blue levels number of intensity for blue components.
Selection Algorithm A group box which enclose a group of radio buttons 

that allow users to select how the palette of the target
image is selected.

# bits An edit box to specify number of bits used to 
determine the resulting palette for some palette 
selection algorithm.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Transform : Custom Conversion and Dithering    

Custom Dithering Dialog
Add New Dithering Matrix Dialog



Add New Dithering Matrix Dialog

Add New Dithering Matrix Dialog Box is invoked when users choose the Custom Conversion 
and Dithering command from the Transform Menu .

Command or Entry Function                                                                                       

Kernel Name An edit box that users can enter to give the mnemonic
name for user defined kernel specified.

Add Filter to Group An edit box that users can enter to specify which filter 
type the user defined kernel belong to. 

Add Filter A push button which indicate users accept user 
defined kernel specified.

User Defined Filter A group box which enclose a group of edit box used to
specify new filter kernel designed.

Dimension A group box which enclose a group of radio button 
used to specify dimension of matrix specifying the 
new user defined filter kernel.

Row An edit box that users can enter to specify number of 
row for the dithering matrix.

Col An edit box that users can enter to specify number of 
column for the dithering matrix.

Type A group box which enclose a group of radio button 
used to specify the new user defined filter kernel 
contain integer or real value.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Transform : Custom Conversion and Dithering    

Custom Dithering Dialog
Build Dithering Palette Dialog



Custom Dithering Dialog

Custom Dithering Dialog Box is invoked when users choose the Custom Conversion and 
Dithering command from the Transform Menu .

Command or Entry Function                                                                                       

Dithering Method (group) A listbox that include various kind of dithering 
operations.

Dithering Filter A combo box that include assortment of 
implementation for particular kind of dithering 
operation chosen.

Dithering Kernel A listbox that show kernel value of a particular 
dithering matrix chosen.

Custom Filter User defined dithering filter.
Target Resolution Specify target resolution.
Delete Filter Delete a user-defined filter from the list.
Save Filter List Save filter list for future use.
Target Quality A group box which enclose a group of radio buttons 

that allow users to select type of target image, i.e. 
whether it is color, gray scale, or bi-level(black and 
white).

Color An edit box that users can enter value to indicate how
many colors of the target image.

Test Test to see the result of conversion or dithering.
Keep Keep the result to the target list for selection.
Clear Clear the current test image.
OK To accept all values entered as default values, click on

OK.
Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

Transform : Custom Conversion and Dithering    

Add New Dithering Matrix Dialog
Build Dithering Palette Dialog



Custom Contrast Dialog

Custom Contrast Dialog Box is invoked when users choose the Special Contrast Control 
command from the Process Menu .

Command or Entry Function                                                                                       

__________________________________________
Related topics:

Process: Special Contrast Control    



Document Page and Paragraph Format Dialog Box

Document Page and Paragraph Format Dialog Box is invoked when users choose Paragraph 
and Page Format command from thecommand from the Option Menu in Document Based 
Processing    mode of operation.

Command or Entry Function                                                                                       

Paragraph Spacing A combo box spacifying the specing between adjacent
paragraph.

Line Spacing A combo box spacifying the specing between lines 
within a paragraph.

Tab Stop A combo box specify tab stop. (not yet implemented).
Measurement Unit A combo box for unit used to specify paragraph 

margin. Usually "inch" should be used as unit of 
measurement. If user specify "number of character" 
as unit of measurement, left and right margin may 
become unevenly aligned due to variable character 
width for different characters.

Page Size A group box which enclose a group of radio buttons 
and edit boxes for user to spacify page size.

Margin A group box which enclose a group of edit boxes for 
user to top, bottom, left and right margin.

For This Paragraph Only A check box which users can check or uncheck to 
indicate whether the setting is for current paragraph 
only or change the setting of the whole page.

RESOLUTION> Horz. An edit box that users can enter value to change the 
horizontal resolution of current document page. The 
setting only affect the printing quality of the 
document page.

RESOLUTION> Vert. An edit box that users can enter value to change the 
vertical resolution of current document page. The 
setting only affect the printing quality of the 
document page.

OK To accept all values entered as default values, click on
OK.

Cancel Abort the operation by clicking on the Cancel button.

__________________________________________
Related topics:

File Menu : Restart Document 
Option Menu : Paragraph and Page Format 











 













































 




